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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The AmpFLSTR™ MiniFiler™ PCR Amplification Kit is a 5-dye, short tandem repeat (STR) multiplex assay
for the direct amplification of human genomic DNA (single-source samples). The kit is optimized for
genotyping degraded and/or inhibited DNA samples.

The kit amplifies the following:

¢ 8 autosomal STR loci: D13S317, D7S5820, D2S1338, D21S11, D16S539, D18S51, CSF1PO and
FGA

* Amelogenin (sex determining marker)

The loci span a range of 70-283 nucleotides with the aid of non-nucleotide linkers to achieve
appropriate spacing between loci.

About the primers

The MiniFiler™ kit uses primers closely flanking the STR repetitive regions (miniSTRs) of the DNA. This
amplification results in amplicons that are significantly shorter in length than those produced in the
AmpFLSTR™ Identifiler™ PCR Amplification Kit and AmpFZSTR™ SGM Plus™ PCR Ampilification Kit. The
comparison is shown in Table 1. Several laboratories confirm that MiniSTRs have a higher success rate
for DNA analysis of degraded DNA samples (Butler et al., 2003; Chung et al., 2004; Coble and Butler,
2005; Drabek et al., 2004; Grubwieser et al., 2006; Wiegand et al., 2001).

To prevent overlap of the miniSTR amplicons in the multiplex, non-nucleotide linkers are used in primer
synthesis for the following loci: CSF1PO, FGA, D16S539, D18S51, Amelogenin, D2S1338, D21S11, and
D7S820. For these primers, non-nucleotide linkers are placed between the primers and the fluorescent
dye during oligonucleotide synthesis (Butler 2005, Grossman et al., 1994, and Baron et al., 1996). Non-
nucleotide linkers enable reproducible positioning of the alleles to facilitate inter-locus spacing. The
combination of a 5-dye fluorescent system and the use of non-nucleotide linkers allows simultaneous
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amplification and efficient separation of the 8 STR loci and Amelogenin during automated DNA fragment

analysis.

Table 1  MiniFiler™ kit amplicon length reduction vs. the Identifiler™ and SGM Plus™ kits

Locus Amplicon length reduction
D7S820 -129 nt
D13S317 -99 nt
D21S11 -33 nt
D2S1338 -183 nt
Amelogenin 0 nt
D18S51 -168 nt
D16S539 -157 nt
FGA —-87 nt
CSF1PO -201 nt
Dyes used in the kit
Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
NED™ Yellow
PET™ Red
LiZz™ Orange One of the following:
® GeneScan™ 500 LIZ™ Size Standard
* GeneScan™ 600 LIZ™ Size Standard v2.0

AmpFESTR™ MiniFiler™ PCR Amplification Kit User Guide 9
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Loci amplified by the kit

Locus Chromosome . . Alleles in DNA
designation location Alleles in the allelic ladder Dye label Control 007

D13S317 13922-31 8,9,10,11,12,13, 14, 15 6-FAM™ |11

D7S820 7q11.21-22 6,7,8,9,10,11,12,13, 14,15 7,12

Amelogenin X: p22.1-22.3 X, Y vic™ X, Y

Y:p11.2

D2S1338 2q35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 20, 23
27,28

D21S11 21q11.2—-g21 24,24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 28, 31
30.2,31,31.2,32,32.2, 33, 33.2, 34, 34.2,
35, 35.2, 36, 37, 38

D16S539 16924—qter 5,8,9,10,11,12,13, 14,15 NED™ 9,10

D18S51 18921.3 7,9,10,10.2, 11,12, 13, 13.2, 14, 14.2, 15, 12,15
16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27

CSF1PO 5033.3-34 6,7,8,9,10,11,12,13,14,15 PET™ 11,12

FGA 4g28 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 24,26
27,28, 29, 30,30.2,31.2,32.2,33.2,42.2,
43.2,44.2,45.2,46.2,47.2,48.2,50.2, 51.2

Standards and controls that are required

The MiniFiler™ kit requires the following standards and controls for PCR amplification, PCR product
sizing, and genotyping:

L Included in
Item Description the kit

DNA Control 007 Positive control. Used to evaluate amplification

efficiency and to evaluate STR genotyping using the Yes

kit allelic ladder. See “DNA Control 007 profile” on

page 12.
MiniFiler™ Allelic Ladder Developed for accurate characterization of the

alleles amplified in the kit. The allelic ladder allows

automatic genotyping of most of the reported alleles Yes

for the loci in the kit. See “Loci amplified by the kit”
on page 10 and “Allelic ladder profile” on page 13.

10
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(continued)
L Included in
Item Description the kit
One of the following: Used for obtaining sizing results. This standard,
e GeneScan™ 500 LIZ™ Size which has been evaluated as an internal size
Standard (Cat. No. 4322682) standard, yields precise sizing results for PCR No (order
products.
e GeneScan™ 600 LIZ™ separately)
Size Standard v2.0
(Cat. No. 4408399)
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I

Contents and storage

The MiniFiler™ kit contains sufficient quantities of the reagents for 100 (Cat. No. 4373872) amplification
reactions at 25 plL/reaction.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

IMPORTANT! The allelic ladder contains PCR products that should not be amplified. To avoid
contamination, store the allelic ladder separately from the other kit components and unamplified DNA.

Note: If there is more than one tube or bottle for a single reagent, thaw only the number of tubes or
bottles required for the current number of reactions.

IMPORTANT! Do not refreeze kit components after thawing.

Note: For recommendations on kit handling, go to thermofisher.com, then search for Technical
Note: Handling STR Kits and Ladder Decontamination, or contact your local Human Identification
representative.

Amount
. - 1
ltem Description 100 reactions Storagel'!
(Cat. No. 4373872)
MiniFiler™ Contains enzyme, salts, dNTPs, 2x0.5mL -25°C to —15°C on receipt.
Master Mix bovine sergm albl.Jmlr.w, and 2-8°C after first use, up to the
0.05% sodium azide in buffer - .
expiration date stated on the kit.
and salt.
DNA Control Contains 0.1 ng/pL human male 1x0.3mL
007 genomic DNA in 0.05% sodium
azide and buffer.?]
See “DNA Control 007 profile”
on page 12.
MiniFiler™ Contains forward and reverse 1x0.5mL -25°C to —-15°C on receipt.
Primer Set frlme;rs to amplify human DNA 2-8°C after first use, up to the
argets. expiration date stated on the kit.
MiniFiler™ Allelic | Contains amplified alleles. 1 x0.05 mL Store protected from light.
Ladder

See “Allelic ladder profile” on
page 13.

[l See packaging for expiration date. Do not use expired product.

2l DNA Control 007 is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation that the
kit reagents can generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you quantify aliquots of
DNA Control 007, the concentration may differ from the labeled concentration.

14
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Required materials not supplied

See Appendix C, “Materials required but not supplied”.

Instruments and software compatibility

Note: Compatible instruments and software that have been discontinued are not listed in this user

guide.

Thermal cyclers
® HID VeritiPro™ Thermal Cycler, 96-well
* ProFlex™ 96-well PCR System
* ProFlex™ 2 x 96-well PCR System
* ProFlex™ 3 x 32-Well PCR System

Genetic analyzers and data collection software

Genetic analyzer

Data collection software

SeqStudio™ Flex Series Genetic Analyzer for
Human Identification

SegStudio™ Flex Series Instrument Software v1.1.1

SeqgStudio™ Genetic Analyzer for HID

SeqgStudio™ Data Collection Software v1.2.5

SegStudio™ Data Collection Software v1.2.4

SeqgStudio™ Data Collection Software v1.2.1

3500 Series Genetic Analyzer for Human
Identification

3500 Series HID Data Collection Software v4.0.1

3500 Series Data Collection Software 4 (Windows™ 10
operating system)

Analysis software

Genetic analyzer

Analysis software

Identification

SeqStudio™ Flex Series Genetic Analyzer for Human

GeneMapper™ ID-X Software v1.7.2 or later

SeqStudio™ Genetic Analyzer for HID

GeneMapper™ ID-X Software v1.6 or later

3500 Series Genetic Analyzer for Human Identification

GeneMapper™ ID-X Software v1.5 or later

AmpFESTR™ MiniFiler™ PCR Amplification Kit User Guide
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For more information

* For the instruments and software used during the kit validation, see Chapter 5, “Experiments and

results”.

For testing information on specific platforms, see the instrument or software user documentation.
* For ordering information, see Appendix C, “Materials required but not supplied”.

Workflow

AmpFESTR™ MiniFiler™ PCR Amplification Kit

Extract and quantify DNA

1. Extract DNA—Go to: www.thermofisher.com/hid-sampleprep
2. Quantify DNA—See “DNA guantification” on page 17

Perform PCR

1. “Prepare the amplification kit reactions” on page 19
2. “Perform PCR” on page 20

Perform capillary electrophoresis

1. “(Before first use of the kit) Set up the capillary electrophoresis instrument” on page 24
2. “Prepare samples for electrophoresis and start the run” on page 27

Analyze data
. “Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 31

. “Create an analysis method” on page 37

. “Analyze and edit sample files with GeneMapper™ ID-X Software” on page 48

y
2
3. “(If needed) Create a size standard definition file” on page 45
4
5. “Examine or edit a project” on page 48
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Validated DNA amounts and PCR cycles

The kit is validated for use with 0.5-0.75 ng/pL of DNA for 30 PCR cycles. The DNA input volume is
10 L, for a total reaction volume of 25 pL.

Perform PCR

Validated DNA amounts and PCR CYCIES . ... ..ottt i i et e e 17
DNA quantification . ...... .. i e e e 17
Before yoU Degin ... ... e e 19
Prepare the amplification kitreactions ......... ... .. . i e 19
PerfOrm PO R .. 20
Direct amplification . ... ... i e e e 21

DNA quantification

Importance of DNA quantification before STR analysis

DNA quantification can be used to determine the following:

If the sample contains sufficient human DNA and/or human male DNA to proceed with short
tandem repeat (STR) amplification.

(When using the Quantifiler™ Trio DNA Quantification Kit) The relative quantities of human male and
female DNA in a sample. Relative quantities can help you select the appropriate STR chemistry.

The amount of sample to use in STR analysis applications.

If PCR inhibitors are present in a sample. If inhibitors are present, the sample may require additional
purification before proceeding to STR analysis.

The DNA quality, in regards to the inhibition level and the DNA degradation level. DNA quality can
help you determine the likelihood of recovery of STR loci with larger amplicon sizes.

Note: Highly degraded samples that cannot be recovered by STR analysis with capillary
electrophoresis can be analyzed with the Precision ID NGS System and Panels. Optimized for
degraded samples, the Precision ID Identity Panel enables discrimination of individuals similar to
STR genotype match probabilities. The Precision ID Ancestry Panel infers biogeographical ancestry
for investigative leads.

AmpFESTR™ MiniFiler™ PCR Amplification Kit User Guide 17
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Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the capillary
electrophoresis instrument (“off-scale” data). Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause a corresponding stutter peak to appear higher in relative
intensity, therefore increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* |ncomplete +A nucleotide addition.
To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added to the
PCR reaction could be extremely low. Unbalanced amplification of the alleles can occur because of
stochastic fluctuation.

Methods of quantifying DNA

Kit Detects How it works
Quantifiler™ HP DNA * Total human DNA | ¢ Uses 5' nuclease assays with multiple-copy target loci, for
Quantification Kit (two targets—one improved detection sensitivity:!']
(Cat. No. 4482911) small amplicon - The human-specific target loci are multiple-copy, and
and one larger dispersed on various autosomal chromosomes
amplicon)

— The primary quantification targets have relatively short
* Degraded DNA amplicons (75-80 bases), to improve the detection of
degraded DNA samples

Quantifiler™ Trio DNA | ¢ Totalhuman DNA | e yses features that maximize consistency of quantification:
Quantification Kit (two targets—one

- Genomic targets have conserved primer- and probe-

(Cat. No. 4482910) small amplicon binding sites
and one larger . L .
amplicon) — Minimal copy number variation between different

individuals and population groups
* Human male DNA Pop grodp

* Contains a Large Autosomal target with a longer amplicon
* Degraded DNA

(>200 bases) to help determine if a DNA sample is degraded

' The detection sensitivity of the Quantifiler™ HP Kit and the Quantifiler™ Trio kit is improved over the Quantifiler™ Duo Kit.

Note: For information on the Quantifiler™ kits, see the Quantifiler™ HP and Quantifiler™ Trio DNA
Quantification Kits User Guide (Pub. No. 4485354).

18 AmpF{STR™ MiniFiler™ PCR Amplification Kit User Guide
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Before you begin

(Optional) Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare the low-TE
buffer as described in this procedure or purchase TE Buffer (Cat. No. 12090015).
1. Mix the buffer components together.
e 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes proportionally for specific needs.

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

(Before first use of the kit) Thaw reagents

Thaw the master mix and primer set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the reagents are stored
at 2-8°C and do not require subsequent thawing. Do not refreeze the reagents.

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

1. Vortex the master mix and primer set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

2. Pipet the required component volumes into an appropriately sized polypropylene tube.

Component Amount per reaction
Master mix 10.0 L
Primer set 5.0 uL

Note: Include volume for extra reactions to provide excess volume for the loss that occurs during
reagent transfers.

3. Vortex the reaction mix for 3 seconds, then briefly centrifuge.
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Perform PCR

4. Pipet 15 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate or
each MicroAmp™ tube.

5. (If needed) Adjust the sample input amount and volume.

¢ [f the total sample input amount is >0.75 ng, dilute with low-TE buffer to obtain a 10-pL input
volume.

¢ [f the total sample input volume is <10 pL, bring to volume with low-TE buffer to obtain a 10-uL
input volume.

6. Prepare the samples and controls as shown in the following table, then add to the appropriate
wells of a MicroAmp™ Optical 96-Well Reaction Plate or to each MicroAmp™ tube.

Amount per reaction

Component
30-cycle protocol
Negative control 10 pL of low-TE buffer
Test sample 10 pL of sample with a total of 0.5-0.75 ng DNA
Positive control Combine, then add to the reaction well or tube:

* 5 pL of DNA Control 007 (0.1 ng/uL)
® 5 uL of low-TE buffer

(For a total amount of 0.5 ng of DNA Control 007)

The final reaction volume (sample or control plus reaction mix) is 25 L.

7. Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film, or cap
the tubes.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps for the plate, which may not provide a
consistent seal across all wells.

8. Vortex the plate or tubes at medium speed for 3 seconds.

9. Centrifuge the tubes or plate at 3,000 x g for ~20 seconds in a tabletop centrifuge (with plate
holders, if using 96-well plates).

Proceed to “Perform PCR” on page 20.

Perform PCR

IMPORTANT! The kit is optimized for use with the thermal cyclers that are listed in “Instruments and
software compatibility” on page 15.

1. Program the thermal cycler.
a. Set the ramping mode to 9600 Simulation.
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Direct amplification

b. Set the thermal cycling conditions as shown in the following table.

Cycle (30 cycles)!']
Initial incubation step Final extension Final hold
Denature Anneal Extend
HOLD CYCLE HOLD HOLD
95°C 94°C 59°C 72°C 60°C 4°C
11 minutes 20 seconds | 2 minutes | 1 minute 45 minutes <24 hoursl?

[ See “Validated DNA amounts and PCR cycles” on page 17.

' The infinity (o) setting allows an unlimited hold time.

2. Load the plate or tubes into the thermal cycler, close the heated cover, then start the run.

3. When the run is complete, store the amplified DNA.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks —25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.

Direct amplification

FTA™ cards or NUCLEIC-CARD™ devices are useful for the collection, storage, and processing of
biological samples. A small punch disk of the card containing the sample can be placed directly into an
amplification tube or plate, purified, then amplified, without transferring the disk.

Our studies indicate that a 1.2-mm bloodstained disk contains ~5-20 ng of DNA. Because of the
high quantity of DNA, a lower cycle number is required to produce on-scale data. In our testing, an
appropriate cycle number for this high quantity of DNA was 24 cycles. We recommend performing
internal validation studies to determine the optimum cycle number for your laboratory.

A 1.2-mm disk of a bloodstained FTA™ card was purified using three washes with FTA™ Purification
Reagent and two washes with 1X low-TE buffer. The disk was then amplified in a MicroAmp™ tube for

24 cycles. See Figure 3.
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Figure 3 Combined dyes electropherogram of a 1.2-mm disk of a bloodstained FTA™ card amplified for
24 cycles with the MiniFiler™ kit on a 3130x/ Genetic Analyzer (Y-axis scale 0-5,000 RFU).
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Perform electrophoresis

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of allelic ladders

One injection

Number of samples per allelic

Lkl to run equals ladder
SegStudio™ 24 Flex Genetic |1 per injection 24 samples 23 samples + 1 allelic ladder
Analyzer
SegStudio™ 8 Flex Genetic 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
Analyzer
SeqgStudio™ Genetic 1 per 6 injections 4 samples 23 samples + 1 allelic ladder
Analyzer
3500xL Genetic Analyzer 1 per injection 24 samples 23 samples + 1 allelic ladder
3500 Genetic Analyzer 1 per 3 injections 8 samples 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment migration speed

and sizing variation between runs. Follow the guidelines in the preceding table, which should account

for normal variation in run speed. To facilitate accurate genotyping of all samples in your laboratory

environment, perform internal validation studies to verify the required allelic ladder injection frequency.

It is critical to genotype using an allelic ladder that is run under the same conditions as the samples.

Size values obtained for the same sample can differ between instrument platforms because of different

polymer matrices and electrophoretic conditions.
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(Before first use of the kit) Set up the capillary
electrophoresis instrument

Data collection software setup

To analyze PCR products generated by the kit, you can use the data collection software and run
parameters provided in this section. See the appropriate table for your instrument.

Note: With 0.5-0.75 ng of input DNA, our studies indicate that the injection conditions provided in this
section produce well-balanced profiles with no instances of allelic dropout and minimal occurrence of
off-scale allele peaks. However, individual CE instrument signal intensities can vary; therefore, changes
to injection parameters may need to be explored and validated to deliver the best results on your
system. Large deviations from the recommended injection parameters can affect the performance of
the size standard and allelic ladder, therefore validation is recommended.

Note: For detailed procedures, see the appropriate user documentation for your instrument.

Table 2 Software setup: SeqStudio™ Flex Series Genetic Analyzer for Human Identification

SeqStudio™ Flex Data
Collection Software

(Optional) Additional software

Run parameters

v1.1.1

e SAE Administrator Console v2.1

* SegStudio™ Plate Manager
Software v2.1, v2.1.1

* SeqStudio™ Flex Remote
Monitoring Software

Injection protocol: HID_Protocol_G5_36_POP4(xlI)

Size standard: GS600 LIZ (60-460)

Dye set: G5 (DS-33)

Run module: HID_G5_36_POP4(xI)

Injection conditions:
* 1.2 kV/15 seconds (8 Flex)
e 1.2 kV/24 seconds (24 Flex)

Run conditions:
* 15KkV/1,210 seconds (8 Flex)
* 15 kV/1,210 seconds (24 Flex)

Table 3 Software setup: SeqStudio™ Genetic Analyzer for HID

SeqStudio™ Plate Manager Software
vi.2, v1.3

SeqStudio™
Data Collection (Optional) Additional software Run parameters Plate setup
Software
vi.2.1,v1.2.4, SAE Administrator Console v2.0, Run Module: HID Analysis | Kit: MiniFiler™ kit
vi.2.5 v2.1

Injection conditions:
1.2 kV/10 seconds

Dye set: G5
(DS-33)

Size standard:
GS600 LIZ (60-460)

Run conditions:
11 kV/1,120 seconds

24
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Table 4 Software setup: 3500 Series Genetic Analyzer for Human Identification

Operating system | 3500 Data Collection Software Run parameters

Windows™ 10 vd, v4.0.1 Assay: AB_G5_LS_POP4(xI)

Instrument protocol: AB_HID36_POP4(xl)_G5

Run module: HID36_POP4 (xI)

Injection conditions: 1.2 kV/15 seconds (xI: 24 seconds)

Run conditions: 15 kV/1,210 seconds

Dye set: G5

Perform spectral calibration

Perform a spectral calibration using the DS-33 Matrix Standard Kit (Dye Set G5) (Cat. No. 4345833).

Examples of spectral calibrations are shown in this section. See the appropriate figure for your
instrument.

G5 (DS-33) Spectral Calibration ®

Dye Matrix View by

Result Spectral QV Condition number Borrowed

Figure 4 Example spectral calibration: SeqStudio™ Flex Series Genetic Analyzer for Human Identification
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G5 (DS-33)™

Dye Matrix

Capillary

Figure 5 Factory-provided spectral calibration: SeqStudio™ Genetic Analyzer for HID

——
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Figure 6 Example spectral calibration: 3500 Series Genetic Analyzer for Human Identification
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Prepare samples for electrophoresis and start the run

Prepare the samples for electrophoresis immediately before loading.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

1. Pipet the required component amounts into an appropriately sized polypropylene tube.

IMPORTANT! The component amounts vary, depending on the size standard that you are using.

Table 5 For GeneScan™ 500 LIZ™ Size Standard

Component Amount per reaction
GeneScan™ 500 LIZ™ Size Standard 0.3 pL
Hi-Di™ Formamide 8.7 uL

Table 6 For GeneScan™ 600 LIZ™ Size Standard v2.0

Component Amount per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.5puL
Hi-Di™ Formamide 8.5 uL

Note: Include additional samples in your calculations to account for the loss that occurs during
reagent transfers.

IMPORTANT! The amount of size standard indicated in the table is a suggested amount.
Determine the appropriate amount of size standard based on your experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Pipet the required component amounts into each well of a MicroAmp™ Optical 96-Well Reaction

Plate.

Component Amount per reaction
Formamide/size standard mixture 9 uL
PCR product or allelic ladder 1L

Note: For blank wells, add 10 yL of Hi-Di™ Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge the plate to ensure
that the contents of each well are mixed and collected at the bottom.

5. Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
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6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.
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Overview of GeneMapper™ ID-X Software

GeneMapper™ ID-X Software is an automated genotyping software application for forensic casework,
databasing, and paternity data analysis.

After capillary electrophoresis, the data collection software stores information for each sample in a FSA
or HID file. The GeneMapper™ ID-X Software allows you to analyze and interpret the data from the FSA
or HID files.

Note: For a list of GeneMapper™ ID-X Software versions that are compatible with your kit and capillary
electrophoresis instrument, see “Instruments and software compatibility” on page 15.
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Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform the appropriate
internal validation studies before you use multiple allelic ladder samples in an analysis.

For multiple allelic ladder samples, the GeneMapper™ ID-X Software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a single run. When the
software imports multiple run folders into a project, only the ladders in their respective run folders
are used for calculating allelic bin offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples, to help ensure proper allele calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

File names and versions used in this section

30

The file names and version numbers of panel, bin, and stutter files that are shown in this section may
differ from the file names that you see when you download or import files.

If you need help to determine the correct files to use, contact your local Human Identification
representative, or go to thermofisher.com/support.
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Set up the GeneMapper™ ID-X Software for analysis (before
first use of the kit)

Workflow

Before you use GeneMapper™ ID-X Software to analyze data for the first time, you must do the
following:

Set up GeneMapper™ ID-X Software

. Check panel, bin, and stutter file versions on your computer
. (If needed) Download newer versions of panel, bin, and stutter files
(If needed) Import panels, bins, and marker stutter

(Optional) Define custom table or plot settings

Check panel, bin, and stutter file versions on your computer

1. Start the GeneMapper™ ID-X Software, then sign in with the appropriate user name and password.

2. Select Tools » Panel Manager.

®

Check the version of files that are currently available in the Panel Manager.
a. Select Panel Manager in the navigation pane.

¥ Panel Manager - .4
File Edit Bins Vi Hel
b. Expand the Panel Manager folder and any == - m 'TN =
subfolders to identify the analysis file version that X |Iife = ai
is already installed for your kit choice. +=« PNl Manager

4. Check the version of files available for import into the Panel Manager.
a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to the Panels folder, then check the version of panel, bin, and stutter files installed.
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

GeneMapper™ ID-X Software v1.7.x contains the latest panel, bin, and stutter files for the STR Kkits.

¢ |[f the latest files are not installed on your copy of the GeneMapper™ ID-X Software, proceed to “(If
needed) Download newer versions of panel, bin, and stutter files” on page 32.

* |[f the latest files are already installed on your copy of the GeneMapper™ ID-X Software, skip to
“Create an analysis method” on page 37.

(If needed) Download newer versions of panel, bin, and stutter files

1. Go to www.thermofisher.com/GMIDXsoftware.

The page provides a list of kit-specific analysis files. The analysis files for each kit can be
downloaded in a single ZIP file.

2. If the analysis file versions listed for your kit are newer than the versions on your computer,
download the ZIP file.

Note: When downloading new versions of analysis files, see the associated Read Me file for
details of changes between software file versions. Perform the appropriate internal validation
studies before using new file versions for analysis.

3. Unzip the file.

(If needed) Import panels, bins, and marker stutter

Import the latest panel, bin set, and marker stutter from the website into the GeneMapper™ ID-X
Software database.

Note: The file names specified in this procedure are examples only. The files that you import may have
different file names.

1. Start the GeneMapper™ ID-X Software, then sign in with the appropriate user name and password.
2. Select Tools » Panel Manager.

3. Open the folder that contains the panels, bins, and marker stutter.

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to the analysis files folder that you unzipped in “(If needed) Download newer
versions of panel, bin, and stutter files” on page 32.
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4. Select the panels TXT file for your kit, then click Import.

4? Import Panels X

oo
o0

Look In: Iﬁ Panels

[} AmpFLSTR_Bins_v7X.txt
() AmpFLSTR_Panels_v7X.txt
) AmpFLSTR_Stutter_v7X.txt

File Name:  [AmpFLSTR_Panels_v7X.td |

Files of Type: |All Files v

| Import ” Cancel |

Importing the panels TXT file creates a new folder in the navigation pane of the Panel Manager.
This folder contains the panels and associated markers.

5. Import the bins file.
a. In the navigation pane, select the panel folder created in step 4.

4? Panel Manager

File Edit Bins View Help

Bin Set: |AmpFLSTR_Bins_v7X |v| @

% ahnPanel Manager i |l (B

L& AmpFLSTR_Panels_v7X Glohalfiler-1QC_Fanel_jnull

o [ SeqStudio_Panels_v7X GlohaIFiIer_ExEress_v null
GlabalFiler_Fanel_v1.2 null
Yhiler_Plus_Panel_v4.2 | null
MGM_Detect_Fanel_w: | null
WeriFiler_Express_Far | null
|dentifiler_Plus_v1 8% |null
[dentifiler_Direct_w1 6% null

@ |~ o [ =] =

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to the analysis files folder for your kit (from step 3).
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d. Select the bins TXT file for your kit, then click Import.

4 Import Bin Set x

LookIn: |3 Panels - IE' E

[} AmpFLSTR_Bins_v7X.txt
[} AmpFLSTR_Panels_v7X.txt
B AmpFLSTR_Stutter_v7X.txt

File Mame: |.AmpFLSTR_EIins_u?J(.trt |

Files of Type: |All Files [~]

Import Cancel

Importing the bins TXT file associates the bin set with the panels imported in step 4.

6. (Optional) View marker and panel information: In the navigation pane, select the panel folder for
your kit.

The panel information is displayed in the right pane and the markers are displayed below it.

4® Panel Manager X

File Edit Bins View Help

M Bin Set |AmpFLSTR_Bins_v7X [~| (@] m e @)

¢ ) AMPFLSTR_Panels_v7X =k Muker Hane  Dye Color Min Size | Max Size | Cortrol Alleles Biker |Commerts ¥ BMaker | Btemal QC
o [CDGlobalfilerHQC_Panel_v4.1X 1 [p135317 |Blue  |90.0 138.0 |11 4 none (| (|
o h-fJGlobaIFiIer_Express_ﬂ 5X “|2 |DFE820 Elue 1415 |1935 |712 4 none (| (|
"h:f?lGlﬂbalFiler_F'ane\_vﬂx 2 |amEL Grean [99.2 108.3 |y g none O O
o [Dfiler_Plus_Panel_v4.2x | |4 |p2s1338" TGreen [1108 1783 [20,23 4 |none ] ]
¢ [EINGH_Detect_Panel_y3.1X 7| |5 [p21s11 Green 1806|2506 |28.31 4 |none O O
IS “_f:'ve”F_"e’—E"preSS-Pa”e's—M'zx ‘|6 |D16S538  |vellow |70.0  |1220 |30 4 none ] ]
o [Ddentifiler_Plus_v1.6X /
o Dldenifiler Dired v1 6X |7 |p1ssst Yellow |1224 |2104 [12,15 4 none O O
P8 MiniFiler v1.6X ‘[s |csFipo Red |@46 [1326 |1112 4 none O O
o [CINGM_SElect_Express_v1.5X A9 |FGA Red 136.4 |296.4 24,26 4 none [ [
o CINGM_SElect_v2.6X I [ 1 I o
o [ Yfiler_v1.6X :
o CINGM_v3.6X
o [CDldentifiler_v1.6X B
o [ldentifiler_CODIS_v1.6X -

e

,;%,Reference Samples

7. Import the stutter file.
a. In the navigation pane, select the panel folder for your kit.

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog box.

c. Navigate to the analysis files folder for your kit (from step 3).
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A gl

d. Select the stutter TXT file for your kit, then click Import.

2? Import Marker Stutter x

LookIn: |] Panels - @ E

[y AmpFLSTR_Bins_v7X.txt
[} AmpFLSTR_Panels_v7X.txt
[} AmpFLSTR_Stutter_v7X.txt

File Mame: AmMpFLETR_Stutter_v7 X bd

Files of Type: |All Files -

Import Cancel

Importing the stutter TXT file associates the marker stutter ratio with the bin set in the panel
folder for your kit (step 4) and overwrites any existing stutter ratios associated with the panels
and bins in that folder.

8. (Optional) View the imported marker stutters.

a. In the navigation pane, click the panel folder for your kit to expand it.
The markers are displayed in the navigation pane.
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b. Double-click a marker, then select the Stutter Ratio & Distance view for the marker in the
right pane.

Note: The allele-specific stutter fields shown in the image are not implemented in
GeneMapper™ ID-X Software v1.6 and earlier.

4? Panel Manager X
File Edit Bins View Help

Bin Set: |AmpFLSTR_Bins_v7X |v 2
I MiniFiler_v1.6X = ) ) ) ’
1 b 'Dﬂqa;? m Please enter the stutter filter(s) for D135317 marker here If left blank, the global stutter filter will be applied
Stutter Ratio & Distance i
Marker thresholds Marker Level Minus Stutter Marker Level Plus Stutter
T AD;ESZU Ratio From Distance |To Distance Ratio From Distance |To Distance
o= AM
b p2stazs || 2 0.1400 3.25 4.75 2 |
& D21811 < <
o D165539 2 3
o D18S51 4 4
- CsFPo [Cew ][ Ean_] [ petete |
o FGA

o CINGM_SElect_Express_v1.5
o [INGM_SElect_v2.6X =
o= [ Yfiler_v1.6X
o= CINGM_v3.6X

= - y Allele-Specific Minus Stutter Allele-Specific Plus Stutter
o [DIdentifiler_v1.6X
o [DIdentifiler_CODIS_v1.6X Ratio Fram Distance  |To Distance Allele Ratio From Distance  |To Distance Allele
o~ [D)Profiler_Plus_v1.6X 1 1 |
o [Profiler_Plus_CODIS_v1.6X P P
o Dcofiler_v1.6X ] 3 3
o [E)COofiler_CODIS_v1.6X
- - 4 4
o ISGM_Plus_v1.6X
o= [ SEfiler_Plus_v1.6X | New || Edit || Delete |

o [IProfiler_v1.6X ~|

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the GeneMapper™ ID-X
Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and
marker stutter are not imported into the GeneMapper™ ID-X Software database.

(Optional) Define custom table or plot settings

Default views for table and plot settings are provided with the software.

For information on defining custom views, see GeneMapper™ ID-X Software v1.5 Getting Started Guide
— Basic Features.
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Create an analysis method

Create an analysis method

IMPORTANT! Because analysis methods are version-specific, you need to create an analysis method
for each version of the software. For example, an analysis method that is created in GeneMapper™ ID-X
Software v1.6 is not compatible with analysis methods that are created in v1.5 or v1.7.x.

1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

L4 GeneMapper™ ID-X Manager X
Find Name Containing: ||
Projects Analysis Methods  Table Settings Plot Settings Matrices Size Standard Report Setti

Project Last Saved Owner # of Samples Description

Test1 2023-12-1912:17 | gmidx 14

Test2 2023-11-02 10:5° | gmicx 4

Import...
Help Done

2. Click the Analysis Methods tab, then click New to open the Analysis Method Editor with the
General tab selected.

3. Enter the settings as described in the following pages.

Note: The Analysis Method Editor closes when you save the settings. To complete this step
quickly, do not save the analysis method until you finish entering the settings in all tabs.

4. After you enter the settings on all tabs, click Save.

Enter Analysis Method settings

Enter General tab settings

1. Enter an analysis method name.
2. Select the security group appropriate for your software configuration.

3. (Optional) Enter a description and an instrument.
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Create an analysis method

4? Analysis Method Editor

[ General | Allele | Peak Detector | Peak Quality | SQ& GQ Settings |

~Analysis Method Description

Mame:

IMy_Analysis_Method

<

Security Group: |GeneMapper ID-X Security Group

Description:

<[l »

Instrument:

Analysis Type: HID

Save

Cancel

Help

Figure 7 General tab settings
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Create an analysis method

A

IMPORTANT! Perform internal validation studies to determine the appropriate settings for your

laboratory.

1. Select the appropriate bin set.

2. (Optional) Select stutter options.

Option

Action

Additional information

Use marker-specific stutter ratio and distance if
available

Select or deselect the

checkbox, as needed.

To apply the stutter ratios that are
contained in the Panel Manager,
select the checkbox.

Use allele-specific stutter ratios and distances if
available

The checkbox is available only for GeneMapper™
ID-X Software v1.7 or later.

Select or deselect the

checkbox, as needed.

To use allele-specific stutter filtering,

select the checkbox.

Consider additive stutters (forward and back)

The checkbox is available only for GeneMapper™
ID-X Software v1.7 or later.

Select or deselect the

checkbox, as needed.

To take additive stutter into
consideration, select the checkbox.

Note: For more information on the GeneMapper™ ID-X Software v1.7 options, see the
GeneMapper™ ID-X Software v1.7 New Features and Software Verification and Validation User

Bulletin (Pub. No. MAN0029209).

3. In the Marker Repeat Type pane, enter values for the Tri, Tetra, Penta, and Hexa loci.

Note: For paternity and database applications: In the Global Cut-off Value field, we
recommended using a cut-off value of 20% for the Tri, Tetra, and Penta loci.

4. Enter the appropriate filter settings.
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Chapter 4 Analyze data with GeneMapper™ ID-X Software

Create an analysis method

4? Analysis Method Editor

[ General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings |

Bin Set |AmpFLSTR_Bins_v7X |-
Use marker-specific stutter ratio and distance if available
|:| Use allele-specific stutter ratios and distances if available.
|:| Consider additive stutters (forward and back).
Marker Repeat Type: Tri Tetra FPenta Hexa
Global Cut-off Value o | foo | [po | [oo |
MinusA Ratio o | o1 | [po | foo |
MinusA Distance From (00 | foo | oo | [oo |
To o0 | [15 | Joo | [oo |
Global Minus Stutter Ratio o | foo | [po | [oo0 |
Global Minus Stutter Distance From (00 | [325 | oo | foo |
To (00 | [475 | Joo | [0 |
Global Plus Stutter Ratio o | foo | [po | [oo0 |
Global Plus Stutter Distance  From (00 | [po | oo | oo |
To (00 | oo | Joo | [oo |
Amelogenin Cutoff (0.0
Range Filter... | Factory Defaul... |
Save cancel Help

Figure 8 Allele tab settings
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Enter Peak Detector tab settings

Enter or select the appropriate values.

Chapter 4 Analyze data with GeneMapper™ /ID-X Software
Create an analysis method

oA

Option

Action

Additional information

Use marker-specific
thresholds (if available)

The checkbox is available

only for GeneMapper™ ID-X

Software v1.7 or later.

Select or deselect the
checkbox, as needed.

To use the marker-specific thresholds defined in the Panel
Manager, select the checkbox.

Ranges

Analysis—Select Full
Range from the
dropdown list.

(if needed) The analysis range can be narrowed.

Sizing—Select All
Sizes from the
dropdown list.

Smoothing and Baselining

Smoothing—Select
Light.

Baseline Window —
Enter 51 pts.

The MiniFiler™ kit was validated with the values listed.

If your laboratory uses an unvalidated polymer, you may
need to adjust these values.

Size Calling Method

Select 3rd Order Least
Squares.

The MiniFiler™ kit was validated using the 3rd Order Least
Squares method.

Do not select another method unless you perform internal
validation studies to determine the appropriate method for
your laboratory.

Peak Detection

Peak
Amplitude Thresholds
—User-defined.

The default value is 50 RFU for all dyes.

Perform internal validation studies to determine the
appropriate peak amplitude thresholds for your laboratory.

Min. Peak Half Width
—Enter 2 pts.

Polynomial Degree—
Enter 3.

Peak Window Size—
Enter 15 pts.

Slope Threshold

Peak Start—Enter 0.0.

Peak End—Enter 0.0.

The MiniFiler™ kit was validated with the values listed.
Do not enter other values unless you perform internal
validation studies to determine the appropriate values for
your laboratory.
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Create an analysis method

(continued)

Option Action Additional information
Use Normalization, if Select or deselect the | To apply size standard normalization data to the analysis,
applicable checkbox, as needed. |select the checkbox.
The checkbox is available The size standard normalization data are collected on the
for use with data run on the capillary electrophoresis instrument. To see if normalization
following instruments: data have been collected for a specific data file, see SS

¢ SeqStudio™ Flex Series Normalization Factor in the GeneMapper™ ID-X Software.

Genetic Analyzer for
Human Identification

® 3500 Series Genetic
Analyzer for Human
Identification
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Create an analysis method -Il;;l.l.

4? Analysis Method Editor X

(‘General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings |

Peak Detection Algorithm: Advanced

|:| Use marker-specific thresholds (if available).

Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
Full Range |v| |AII Sizes |v| B: | | R: | |
Start Pt Start Size
G | lp: | |
Stop Pt Stop Size
\a lo: | |

~ Smoothing and Baselining
Smoothing Mone

@ Light Min. Peak Half Width: 2 1
i) Heawy Polynomial Degree: |3
Baseline Window: |51 pts Peak Window Size: |15 |pts

e Slope Threshold

r Si i

e e Peak Start 0.0
i) 2nd Order Least Squares
) 3rd Order Least Squares Peak End. 0.0

i Cubic Spline Interpolation
V' Local Southern Method

Normalization

(_ Global Southern Method [ ] use Normalization, if applicable
Factory Defaults
Save As Save Cancel Help

Figure 9 Peak Detector tab settings

Enter Peak Quality tab settings

1. Perform internal validation studies to determine the heterozygous and homozygous minimum peak
height thresholds, maximum peak height threshold, and the minimum peak height ratio threshold
for interpretation of data.

2. For the remaining fields, enter the values shown in Figure 10.

Note: The Pull-Up Ratio (PU) settings shown in the figure are implemented only in GeneMapper™
ID-X Software v1.7 or later. For more information on these settings, see the GeneMapper™

ID-X Software v1.7 New Features and Software Verification and Validation User Bulletin

(Pub. No. MAN0029209).
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Create an analysis method

at Analysis Method Editor

Min/Max Peak Height (LPH/MPH})
Homozygous min peak height

Heterozygous min peak height
Max Peak Height (MPH)

Peak Height Ratio (PHR)
Min peak height ratio

Broad Peak (BD)
Max peak width (basepairs)

Allele Number (AN)

Max expected alleles:
For autosomal markers & AMEL
For Y markers

Allelic Ladder Spike

70U LU

Spike Detection

|Enable |

Al

Cut-offvalue

Sample Spike Detection

0.2

Spike Detection

|Enable |

L

Pull-Up Ratio {PU)

|:| Enable pull-up detection.
@ Label pull-up

{_ Remove pull-up peaks

Max pull-up ratio

Pull-up offset (data points)

05

I

|/General |/ Allele r Peak Detector |T Peak Quality r 50 & GQ Settings

Save As Save

Cancel

Help

Figure 10 Peak Quality tab settings

Enter SQ & GQ tab settings

Enter the appropriate values.

IMPORTANT! The software default values are shown in Figure 11. We used the software default
values during developmental validation. We recommend that you perform internal validation studies to

determine the appropriate values for your laboratory.
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(If needed) Create a size standard definition file

4? Analysis Method Editor X

[ General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings |

Quality weights are between 0 and 1.
- Sample and Control GQ Weighting

Broad Peak (BD) 0.8 Allele Mumber (AN) 1.0
Out of Bin Allele (BIMN) 0.8 Low Peak Height (LPH) 0.3
Overlap (OVL) 0.8 Max Peak Height (MPH)} 0.3
Marker Spike (SPK) 03 Off-scale (0OS) 08
AMEL Cross Check (A... |0.0 Peak Height Ratio (PH... |0.3
Control Concordance (CC) Weight = 1.0 {Only applicable to controls)

- S0 Weighting
Broad Peak (BD) 05

~Allelic Ladder GQ Weighting

<

Spike (SSPKISPK) Off-scale (0OS)

£

- 5Q & GQ Ranges

Sizing Quality: From |0.75 to1.0 From00to |0.25
Genotype Qualityy.  From |0.75 to1.0 From00to |0.25

Reset Defaults

Save Cancel Help

Figure 11 SQ & GQ tab settings

(If needed) Create a size standard definition file

If you cannot use the default settings that are provided, create a new size standard definition file.
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(If needed) Create a size standard definition file

About the size standard definition file

Two size standard definition files are provided with the GeneMapper™ ID-X Software. Select the
appropriate file depending on the size standard that was used in the capillary electrophoresis run
(“Prepare samples for electrophoresis and start the run” on page 27).

e CE_G5_GS500 (75-400)— For use with the GeneScan™ 500 LIZ™ Size Standard. The file contains
the following peaks: 75, 100, 139, 150, 160, 200, 300, 350, 400, 450. (The 250 and 340 peaks are
not included in the definition. These can be used as an indicator of precision in the run.)

* GS600_LIZ_(60-460)—For use with the GeneScan™ 600 LIZ™ Size Standard v2.0. The file contains
the following peaks: 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300,
314, 320, 340, 360, 380, 400, 414, 420, 440, and 460.

Both size standard definitions are supported for use with this kit on the genetic analyzers listed in
“Instruments and software compatibility” on page 15. If you need to create your own size standard
definition, see “Create a size standard definition file” on page 46.

Create a size standard definition file
1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

2. Click the Size Standards tab, then click New.

o GeneMapper™ ID-X Manager X

Find Name Containing:

Projects  Analysis Methods  Table Settings  Plot Settings  Matrices  Size Standards  Report Settings

Name Last Saved Owner Type Description
CE_F_HID_GS500 (75-400) 2007-08-09 21:23:52.288  |gmidx Advanced | |
CE_F_HID_GS500 (75-450) 2007-08-09 21:24:09.052 gmidx Advanced

CE_G5_HID_GS500 2008-10-11 21:12:27.0 gmidx Advanced

GS600_LIZ 2007-06-26 18:43:119.0 gmidx Advanced
GS600_LIZ+Normalization_(60-460) 2012-08-06 20:37:29.049 grmidx Advanced =
GSB00_LIZ+Normalization_(80-400) 2012-08-06 20:37:37.785  |gmidx Advanced

GS600_LIZ_(60-460) 2012-08-06 20:21:32.24 grmidx Advanced

GS600_LIZ_{80-400) 2007-06-27 09:43:19.0 gmidx Advanced
RapidHITID_GS600_Size_Standard 2022-09-08 23:17:46.73 gmidx Advanced |
RapidHITID_SS3_Size_Standard 2018-10-0510:02:10.807 gmidx Advanced A

Help Done

3. Specify settings in the Size Standard Editor.
a. Enter a name.

b. In the Security Group field, select the security group appropriate for your software
configuration.

c. In the Size Standard Dye field, select Orange.
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(If needed) Create a size standard definition file = =1

d. In the Size Standard Table, enter the peak sizes that correspond to your size standard. (If
needed) Click Insert to add rows or click Delete to remove rows.

4 Size Standard Editor >
Edit
- Size Standard Description
Mame: My_Size_Stan dard|

Security Group: GeneMapper ID-X Security Group -

Diescription:

Size Standard Diye: Orange -

r Size Standard Table
Size in Basepairs
1 0.0

Insert Delete

0o

[ m -|T|_

0o

0o

0.0

0o

= | | n| s | M

0o

L4 ]

oK Cancel Help
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Analyze and edit sample files with GeneMapper™ ID-X Software

Analyze and edit sample files with GeneMapper™ ID-X
Software

1. In the Project window, select Edit » Add Samples to Project, then navigate to the disk or
directory that contains the sampile files.

2. Apply analysis settings to the samples in the project.

Option Action

Sample Type Select the sample type for each sample, control, and allelic ladder in the project.

Analysis Method | Select the analysis method that you created in “Create an analysis method” on
page 37.

Panel Select the current kit panel. If needed, see “Check panel, bin, and stutter file
versions on your computer” on page 31.

Size Standard Select the GS600_LIZ_(60-460) size standard definition, or select another validated
size standard definition, as described in “(If needed) Create a size standard
definition file” on page 45.

3. Click Analyze.

4. In the Save Project dialog box, enter a name for the project, then click OK to start analysis.
* The status bar displays the progress of analysis.

* The table displays the row of the sample currently being analyzed in green (or red if analysis
failed for the sample).

* The Analysis Summary tab is displayed, and the Genotypes tab is available when the
analysis is complete.

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project window to
examine the data.

For more information on using the GeneMapper™ ID-X
Software

See “Related documentation” on page 122 for a list of available documents.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an evaluation of the
efficiency, reliability, and performance characteristics of the procedure. By challenging the procedure
with samples that are commonly encountered in forensic and parentage laboratories, the validation
process uncovers attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

The experiments described in this chapter were performed according to the DNA Advisory Board (DAB)
Quality Assurance Standards, effective October 1, 1998 (DAB, 1998). The DAB standards describe the
quality assurance requirements that a laboratory should follow to maintain the quality and integrity of
the data and competency of the laboratory.

Additional validation was performed according to the revised guidelines from the Scientific Working
Group on DNA Analysis Methods (SWGDAM, July 10, 2003). Based on these guidelines, we conducted
experiments that comply with guidelines 1.0 and 2.0 and its associated subsections. This DNA
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Laboratory requirements for internal validation

methodology is not novel (Moretti et al., 2001; Frank et al., 2001; Wallin et al., 2002; and Holt et al.,
2000).

This chapter discusses many of the experiments that we performed and provides examples of the
results we obtained. We chose conditions that produced optimum PCR product yield and that met
reproducible performance standards. While these experiments are not exhaustive, it is our opinion that
the experiments are appropriate for a manufacturer of STR kits intended for forensic and/or parentage
testing use.

Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance of this kit is
supported when used according to the following developmentally validated parameters. Modifications
to the protocol should be accompanied by appropriate validation studies performed by the laboratory.

Developmental validation

SWGDAM guideline 1.2.1

“Developmental validation is the demonstration of the accuracy, precision, and reproducibility of a
procedure by the manufacturer, technical organization, academic institution, government laboratory, or
other party.” (SWGDAM, July 2003)

SWGDAM guideline 2.10.1

“The reaction conditions needed to provide the required degree of specificity and robustness must
be determined. These include thermal cycling parameters, the concentration of primers, magnesium
chloride, DNA polymerase, and other critical reagents.” (SWGDAM, July 2003)

PCR components

We examined the concentration of each component in the kit. We established that the concentration
of each component was within the range where data indicated that the amplification met the required
performance criteria for specificity, sensitivity, and reproducibility.

For example, various magnesium chloride concentrations were tested on the 3130x/ Genetic Analyzer.
The ampilification of 0.50 ng of DNA Control 007 is shown in Figure 12. The performance of the
multiplex is most robust within +20% of the optimal magnesium chloride concentration.
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Figure 12 A 0.50 ng sample of DNA Control 007 amplified with the MiniFiler™ kit in the presence of varying
concentrations of magnesium chloride and analyzed on a 3130x/ Genetic Analyzer (Y-axis scale 0-5,000 RFU).

Thermal cycling temperatures

Thermal cycling parameters were established for amplification of the MiniFiler™ kit. Thermal cycling
times and temperatures of GeneAmp™ PCR systems were verified. Varying annealing and denaturation
temperature windows were tested to verify that a specific PCR product with the desired sensitivity of
>0.50 ng of DNA Control 007 was produced.

For example, annealing temperatures of 55, 57, 59, 61, and 63°C were tested for 2-minute hold times
in the Silver 96-Well GeneAmp™ PCR System 9700 (see Figure 13). The PCR products were analyzed
using a 3130x/ Genetic Analyzer.

Of the tested annealing temperatures, 55-61°C produced robust profiles. At 63°C, the yield of the
majority of loci was significantly reduced. No preferential amplification was observed at the standard
annealing temperature of 59°C. Thermal cycler temperature is critical to assay performance; therefore,
we strongly recommend regularly scheduled thermal cycler calibration.
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Figure 13 Electropherograms obtained from amplification of 0.50 ng of DNA Control 007 at annealing
temperatures of 55, 57, 59, 61, and 63°C, analyzed on a 3130x/ Genetic Analyzer (Y-axis scale 0-4,000 RFU).

PCR cycle number

Reactions were amplified for 28, 29, 30, 31 and 32 cycles on the Silver 96-Well GeneAmp™ PCR
System 9700 using 0.50 ng from three DNA samples. As expected, the amount of PCR product
increased with the number of cycles. A full profile was generated at 28 cycles and off-scale data were
collected for several allele peaks at 32 cycles (see Figure 14).

While none of the cycle numbers tested produced nonspecific peaks, 30 cycles were found to give
optimal sensitivity when the amplified products were analyzed on a 3130x/ Genetic Analyzer.
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Figure 14 Representative MiniFiler™ kit profiles obtained from amplification of 0.50 ng of DNA template using 28,
29, 30, 31, and 32 cycles, analyzed on a 3130x/ Genetic Analyzers (Y-axis scale 0-4,000 RFU).

Accuracy, precision, and reproducibility

SWGDAM guideline 2.9

“The extent to which a given set of measurements of the same sample agree with their mean and the
extent to which these measurements match the actual values being measured should be determined.”
(SWGDAM, July 2003)

Accuracy observation

The size differences that are typically observed between sample alleles and the MiniFiler™ Allelic Ladder
alleles on the 3130x/ Genetic Analyzer with POP-4™ Polymer are shown in Figure 15. The X-axis
represents the nominal base pair sizes for the allelic ladder. The dashed lines parallel to the X-axis
represent the +£0.25-bp windows. The Y-axis represents the deviation of each sample allele size from
the corresponding allelic ladder allele size. All sample alleles are within +0.5 bp from a corresponding
allele in the allelic ladder.
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Figure 15 Allele size vs. allelic ladder sizing for 42 samples analyzed on a 3130x/ Genetic Analyzer

Precision and size window description

Sizing precision enables the determination of accurate and reliable genotypes. The recommended
method for genotyping is to use a +0.5-bp “window” around the size obtained for each allele in

the allelic ladder. A +0.5-bp window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be one of the following:

* An “off-ladder” allele; that is, an allele of a size that is not represented in the allelic ladder
* An allele that does correspond to an allele in the allelic ladder, but whose size is just outside a
window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of precision in
sizing an allele multiple times. Precision is measured by calculating the standard deviation in the size
values obtained for an allele that is run in several injections on a capillary electrophoresis instrument.
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Precision and size window observation

Typical precision results obtained from 5 runs (16 capillaries/run) of the MiniFiler™ Allelic Ladder on

a 3130x/ Genetic Analyzer (36-cm capillary and POP-4™ polymer) using GeneScan™ 500 LIZ™ Size
Standard are shown in Table 7. The results were obtained within a set of injections on a single capillary
array.

Sample alleles can occasionally size outside the +0.5-bp window for a respective allelic ladder allele
because of measurement error. The frequency of such an occurrence is lowest in detection systems
that have the smallest standard deviations in sizing. The tight clustering of allele sizes obtained on the
3130x/ Genetic Analyzer, where the standard deviation in sizing is typically <0.15 bp, is illustrated in
Figure 15. The instance of a sample allele sizing outside the +0.5-bp window because of measurement
error is relatively rare when the standard deviation in sizing is approximately <0.15 bp (Smith, 1995).

For sample alleles that do not size within a +0.5-bp window, the PCR product must be rerun

to distinguish between a true off-ladder allele versus measurement error of a sample allele that
corresponds with an allele in the allelic ladder. Repeat analysis, when necessary, provides an added
level of confidence in the final allele assignment.

GeneMapper™ ID-X Software automatically flags sample alleles that do not size within the prescribed
window around an allelic ladder allele by labelling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections. Cross-platform

sizing differences occur due to a number of factors, including type and concentration of polymer, run
temperature, and electrophoresis conditions. Variations in sizing can also occur between runs on the
same instrument and between runs on different instruments of the same platform type because of these
factors.

We strongly recommend that you compare the allele sizes to the sizes obtained for known alleles in the
MiniFiler™ Allelic Ladder from the same run, then convert to genotypes as described in “Allelic ladder
requirements for data analysis” on page 30. The results of five runs of the MiniFiler™ Allelic Ladder on a
3130x/ Genetic Analyzer are shown in Table 7. The table shows the following:

* Mean—The mean sizes calculated for all alleles in each run (16 capillaries). The mean range
represents the lowest and highest mean size values obtained across all five runs.

¢ Standard deviation—The standard deviation for the allele sizing calculated for all alleles in each
run. The standard deviation range represents the lowest and highest standard deviation values
obtained across all five runs.

Note: For more information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield et al.,
1998.

Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler™ Allelic Ladder on a 3130x/
Genetic Analyzer

Allele Mean Standard deviation
AMEL
X 101.54-101.59 0.024-0.037
Y 107.51-107.56 0.029-0.038
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
CSF1PO
6 86.65-86.67 0.027-0.038
7 90.70-90.72 0.026-0.038
8 94.72-94.77 0.023-0.036
9 98.76-98.79 0.033-0.041
10 102.79-102.81 0.028-0.038
11 106.80-106.85 0.031-0.044
12 110.82-110.85 0.030-0.043
13 114.83-114.88 0.027-0.045
14 118.83-118.87 0.023-0.041
15 122.83-122.89 0.031-0.041
D13S317
8 103.25-103.28 0.029-0.039
9 107.38-107.43 0.028-0.042
10 111.50-111.54 0.035-0.044
11 115.63-115.66 0.031-0.045
12 119.73-119.78 0.037-0.044
13 123.82-123.85 0.038-0.047
14 127.83-127.88 0.038-0.049
15 131.93-131.97 0.035-0.051
D16S539
5 74.96-75.01 0.033-0.047
8 87.58-87.61 0.030-0.044
9 91.78-91.81 0.021-0.039
10 95.91-95.95 0.038-0.046
11 100.06-100.09 0.038-0.046
12 104.20-104.22 0.041-0.045
13 108.30-108.36 0.031-0.044
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
14 112.42-112.46 0.037-0.050
15 116.52-116.58 0.037-0.048

D18S51
7 124.68-124.73 0.035-0.060
9 132.53-132.57 0.044-0.059
10 136.46-136.50 0.040-0.056
10.2 138.37-138.42 0.040-0.056
11 140.38-140.43 0.038-0.055
12 144.33-144.37 0.039-0.059
13 148.27-148.31 0.048-0.054
13.2 150.19-150.22 0.040-0.062
14 1562.21-152.24 0.043-0.057
14.2 154.14-154.18 0.035-0.054
15 156.17-156.20 0.042-0.061
16 160.13-160.16 0.047-0.060
17 164.06-164.10 0.046-0.057
18 168.05-168.06 0.039-0.058
19 172.00-172.02 0.041-0.054
20 175.97-175.99 0.035-0.061
21 179.93-179.96 0.045-0.055
22 183.92-183.95 0.048-0.064
23 187.89-187.94 0.043-0.062
24 191.87-191.91 0.045-0.058
D18S51
7 124.68-124.73 0.035-0.060
9 132.53-132.57 0.044-0.059
10 136.46-136.50 0.040-0.056
10.2 138.37-138.42 0.040-0.056
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
11 140.38-140.43 0.038-0.055
12 144.33-144.37 0.039-0.059
13 148.27-148.31 0.048-0.054

13.2 150.19-150.22 0.040-0.062
14 1562.21-152.24 0.043-0.057
14.2 154.14-154.18 0.035-0.054
15 156.17-156.20 0.042-0.061
16 160.13-160.16 0.047-0.060
17 164.06-164.10 0.046-0.057
18 168.05-168.06 0.039-0.058
19 172.00-172.02 0.041-0.054
20 175.97-175.99 0.035-0.061
21 179.93-179.96 0.045-0.055
22 183.92-183.95 0.048-0.064
23 187.89-187.94 0.043-0.062
24 191.87-191.91 0.045-0.058
25 195.85-195.87 0.053-0.070
26 199.86-199.89 0.047-0.063
27 203.84-203.88 0.044-0.070
D21S11
24 186.96-186.99 0.056-0.067

24.2 188.95-188.97 0.047-0.066
25 190.89-190.92 0.051-0.071
26 194.82-194.84 0.052-0.063
27 198.67-198.7 0.053-0.071
28 202.71-202.74 0.055-0.065

28.2 204.63-204.66 0.060-0.070
29 206.73-206.77 0.048-0.072
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
29.2 208.50-208.55 0.051-0.077
30 210.59-210.63 0.053-0.075
30.2 212.53-212.59 0.058-0.067
31 214.54-214.59 0.054-0.069
31.2 216.51-216.55 0.054-0.075
32 218.48-218.55 0.051-0.067
32.2 220.48-220.53 0.057-0.073
33 222.46-222.51 0.055-0.073
33.2 224.52-224.57 0.052-0.078
34 226.35-226.39 0.054-0.063
34.2 228.42-228.47 0.049-0.072
35 230.35-230.40 0.047-0.081
35.2 232.38-232.45 0.055-0.083
36 234.42-234.48 0.053-0.080
37 238.31-238.36 0.057-0.074
38 242.41-242.47 0.063-0.077
D2S1338
15 120.06-120.10 0.032-0.042
16 124.11-124.16 0.028-0.044
17 128.07-128.12 0.031-0.044
18 132.04-132.08 0.036-0.051
19 136.05-136.08 0.028-0.046
20 140.00-140.04 0.028-0.045
21 144.01-144.04 0.034-0.043
22 147.99-148.02 0.029-0.039
23 151.96-151.99 0.034-0.044
24 155.95-155.97 0.029-0.042
25 159.93-159.94 0.038-0.049
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
26 163.91-163.94 0.032-0.055
27 167.99-168.01 0.033-0.052
28 172.24-172.26 0.038-0.052

D7S820
6 149.69-149.73 0.032-0.051
7 153.65-153.68 0.036-0.051
8 157.62-157.65 0.031-0.051
9 161.59-161.62 0.032-0.057
10 165.55-165.57 0.035-0.046
11 169.53-169.54 0.037-0.050
12 173.50-173.52 0.034-0.055
13 177.48-177.50 0.041-0.047
14 181.46-181.49 0.034-0.050
15 185.45-185.47 0.034-0.053
FGA
17 150.52-150.55 0.031-0.040
18 154.26-154.29 0.031-0.043
19 158.03-158.04 0.029-0.047
20 161.78-161.80 0.033-0.044
21 165.55-165.57 0.030-0.042
22 169.32-169.34 0.031-0.047
23 173.11-173.12 0.032-0.041
24 176.88-176.91 0.034-0.048
25 180.68-180.70 0.025-0.045
26 184.49-184.51 0.031-0.047
26.2 186.29-186.34 0.027-0.049
27 188.34-188.37 0.022-0.047
28 192.20-192.25 0.037-0.047
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Table 7 Precision results of five runs (16 capillaries/run) of the MiniFiler Allelic Ladder on a 3130xI
Genetic Analyzer (continued)

Allele Mean Standard deviation
29 195.97-196.02 0.032-0.046
30 199.69-199.74 0.032-0.047

30.2 202.12-202.17 0.034-0.055
31.2 205.94-205.98 0.034-0.055
32.2 209.74-209.80 0.034-0.051
33.2 213.57-213.64 0.035-0.064
42.2 248.46-248.55 0.042-0.064
43.2 252.35-252.43 0.038-0.067
44.2 256.39-256.46 0.043-0.064
45.2 260.28-260.36 0.043-0.054
46.2 263.89-263.95 0.040-0.055
47.2 267.71-267.77 0.039-0.057
48.2 271.69-271.76 0.040-0.058
50.2 279.48-279.54 0.036-0.062
51.2 283.23-283.28 0.041-0.061

Extra peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes for the
appearance of extra peaks include stutter products, incomplete 3" A nucleotide addition (at the n-1
position), dye artifacts, and mixed DNA samples.

Extra peaks: Stutter

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat
unit smaller than the target STR allele product (minus stutter), or less frequently, one repeat larger

(plus stutter) (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at tetranucleotide
STR loci has revealed that the minus stutter product is missing a single tetranucleotide core repeat unit
relative to the main allele (Walsh et al., 1996). Although plus stutter is normally much less significant
than minus stutter in STR loci with tetranucleotide repeats, the incidence of plus stutter may be more
significant in trinucleotide repeat-containing loci.
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Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is measured by dividing
the height of the stutter peak by the height of the main allele peak.

Stutter observation

Peak heights were measured for amplified samples at the loci that are used in the kit. All data
were generated on the 3130x/ Genetic Analyzer. Some conclusions from these measurements and
observations are:

* For each locus, the stutter percentage generally increases with allele length.
¢ Smaller alleles typically show a lower level of stutter relative to the longer alleles in each locus.
* Each allele in a locus displays a consistent stutter percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified in the software are
not filtered. (Stutter filter percentage is calculated as the mean stutter for the locus plus 3 standard
deviations.) Peaks in the stutter position that have not been filtered and remain labeled can be
further evaluated.

* The measurement of stutter percentage for allele peaks that are off-scale may be unusually high
due to artificial truncation of the main allele peak.

® Stutter can be elevated when minus stutter and plus stutter overlap. This is typically observed
when a given allele flanks another allele that is 2 repeat units away.

* The magnitude and/or variability of stutter may increase with low DNA input amounts.

Marker-specific plus stutter observed in the population study with the MiniFiler™ kit is shown in
Figure 16 through Figure 19.

The stutter filter settings that are derived from these data are listed in “Stutter filter settings provided
with the GeneMapper™ ID-X Software” on page 66.
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Figure 16 Stutter percentages for D13S317 and D7S820 loci (blue=6-FAM™ dye).
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Figure 17 Stutter percentages for the D2S1338 and D21S11 loci (green=VIC™ dye).
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Figure 19 Stutter percentages for the CSF1PO and FGA loci (red=PET™ dye).

Stutter filter settings provided with the GeneMapper™ ID-X Software

The stutter filter settings are shown in Table 8. The data used to derive the settings are shown in
Figure 16 through Figure 19. The proportion of the stutter product relative to the main allele (stutter
percent) is measured by dividing the height of the stutter peak by the height of the main allele peak.

IMPORTANT! The values that are shown in the table are the values that were determined during
developmental validation studies using specific data sets. To determine the appropriate values to use
for your applications, always perform internal validation studies.

Table 8 Percentages used in the stutter filters included with the GeneMapper™ ID-X Software

Locus % Stutter
D13S317 14
D7S820 11
D2S1338 18
D21S11 16
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Table 8 Percentages used in the stutter filters included with the GeneMapper ID-X Software

(continued)
Locus % Stutter
D16S539 15
D18S51 18
CSF1PO 14
FGA 15

Extra peaks: Addition of 3' A nucleotide

3’ A nucleotide addition definition

Many DNA polymerases can catalyze the addition of a single nucleotide (predominantly adenosine) to
the 3’ ends of double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate
addition results in a PCR product that is one nucleotide longer than the actual target sequence. The
PCR product with the extra nucleotide is referred to as the “+A” form.

3’ A observation

The efficiency of +A addition is related to the particular sequence of the DNA at the 3" end of the PCR
product. The kit includes two main design features that promote maximum +A addition:

* The primer sequences have been optimized to encourage +A addition.
¢ The PCR chemistry allows complete +A addition with a short final incubation for 5 minutes at 60°C.

This final extension step gives the DNA polymerase additional time to complete +A addition to all
double-stranded PCR products. STR systems that have not been optimized for maximum +A addition
may have “split peaks”, where each allele is represented by 2 peaks that are 1 bp apart. Examples of
incomplete and normal +A addition are shown in Figure 20.

Lack of complete +A nucleotide addition may be observed in the MiniFiler™ kit results when the amount
of input DNA is greater than the recommended protocols, because more time is needed for the DNA
polymerase to add the +A nucleotide to all molecules as more PCR product is generated. Amplification
of too much input DNA may also result in off-scale data.
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Figure 20 Omitting the final extension step resulted in split peaks due to incomplete A nucleotide
addition. These data were generated on the 310 Genetic Analyzer using another AmpFESTR™ kit.

Extra peaks: Artifacts

Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are typically reproducible.
Anomalies are non-reproducible, intermittent occurrences that are not observed consistently in a
system (for example, spikes and baseline noise).

Artifact observation

Artifacts have been seen in data produced on genetic analyzers when using the MiniFiler™ kit. In
amplified samples, artifacts in the non-calling region may appear in the 6-FAM™ (70 bp) and VIC™
(80 bp) dyes. Low-level artifacts in the calling region may appear in the 6-FAM™ (117 bp and 127 bp),
VIC™ (118 bp), and NED™ (166 bp) dyes, depending on the sensitivity of the instrument.

Examples of baseline noise and artifacts in an electropherogram while using the MiniFiler™ kit are
shown in Figure 21. You should consider possible noise and artifacts when interpreting data from the
MiniFiler™ kit on the 3130x/ Genetic Analyzer.

Note: To illustrate these artifacts, a high degree of magnification (Y-axis) is used in Figure 21.
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Figure 21 Examples of baseline noise and reproducible artifacts in data produced on a 3130x/ Genetic

Analyzer

Another type of PCR artifact occurs when the amount of input DNA exceeds the recommended amount
(0.50-0.75 ng). These artifacts were characterized as secondary stutter products in D13S317 and
D21S11 as shown in the bottom example in Figure 21. Their mobility varies with that of the main

amplification product.

Genotyping may result in the detection of these artifacts as off-ladder (OL) alleles.
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Characterization of loci

SWGDAM guideline 2.1

“The basic characteristics of a genetic marker must be determined and documented.” (SWGDAM, July
2003)

Loci in this kit

This section describes basic characteristics of the 8 loci and sex-determining marker (Amelogenin) that
are amplified with the MiniFiler™ kit. Most of these loci have been extensively characterized by other
laboratories.

Nature of polymorphisms

The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1 of the X homologue.
Amplification results in 104-bp and 110-bp products from the X and Y chromosomes, respectively.
(Sizes are the actual nucleotide size according to sequencing results, including 3” A nucleotide addition.)
The remaining MiniFiler™ kit loci are all tetranucleotide short tandem repeat (STR) loci. The length
differences among alleles of a particular locus result from differences in the number of 4-bp repeat
units.

We have sequenced all the alleles in the MiniFiler™ Allelic Ladder. In addition, other groups in the
scientific community have sequenced alleles at some of these loci. Among the various sources of

sequence data on the MiniFiler™ kit loci, there is consensus on the repeat patterns and structure of the
STRs.

Inheritance

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from families of Utah
Mormon, French Venezuelan, and Amish descent. These DNA sets have been extensively studied all
over the world and are routinely used to characterize the mode of inheritance of various DNA loci.
Each family set contains three generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance patterns
(Begovich et al., 1992).

Mapping

The MiniFiler™ kit loci have been mapped, and the chromosomal locations have been published
(Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills et al., 1992; Sharma and Litt,
1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996; and Lareu, et al., 1996).

Species specificity

SWGDAM Guideline 2.2

“For techniques designed to type human DNA, the potential to detect DNA from forensically relevant
nonhuman species should be evaluated.” (SWGDAM, July 2003)
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Nonhuman study observation

The MiniFiler™ kit provides the required specificity for detecting human alleles. Species specificity
testing was performed to show that there is no cross-reactivity with nonhuman DNA that may be
present in forensic casework samples.

The following species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the kit:

* Primates— Gorilla, chimpanzee, orangutan, and macaque (0.50 ng each)

* Non-primates—Mouse, dog, pig, cat, horse, hamster, rat, chicken, and cow (10 ng each)

* Microorganisms—Candida albicans, Escherichia coli, Lactobacillus casei, Staphylococcus aureus,
Neisseria gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus (equivalent to 10° copies)

Results were evaluated for the presence of any amplified peaks that would indicate cross-reactivity of
the kit with any of these non-human species.

The chimpanzee and gorilla DNA samples produced partial profiles within the 70-283 bp region. The
remaining species tested did not yield reproducible detectable products.

Example electropherogram results from the species specificity tests are shown in Figure 22.
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Figure 22 Representative electropherograms from a species specificity study including positive and negative
controls (Y-axis scale 0-180 or 0-4,000 RFU).
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SWGDAM guideline 2.3

“When appropriate, the range of DNA quantities able to produce reliable typing results should be
determined.” (SWGDAM, July 2003)

Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the capillary

electrophoresis instrument (“off-scale” data). Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause a corresponding stutter peak to appear higher in relative
intensity, therefore increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* |Incomplete +A nucleotide addition.
To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added to the

PCR reaction could be extremely low. Unbalanced amplification of the alleles can occur because of
stochastic fluctuation.
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Sensitivity observation

The amplification results of different input DNA amounts are shown in Figure 23.

To determine an appropriate minimum peak height threshold for your instruments and data, perform
internal validation studies.
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Figure 23 Effect of amplifying 1 ng, 0.5 ng, 0.25 ng, 0.125 ng, and 0.62 ng of DNA Control 007. Data analyzed
using the 3130x/ Genetic Analyzer (Y-axis scale 0-1,000, 0-1,600, 0-3,000, 0—4,000, or 0-6,000 RFU; the Y-axis
scale is magnified for the lower amounts of DNA).

Stability

SWGDAM guideline 2.4

“The ability to obtain results from DNA recovered from biological samples deposited on various
substrates and subjected to various environmental and chemical insults has been extensively
documented. In most instances, assessment of the effects of these factors on new forensic DNA
procedures is not required. However, if substrates and/or environmental and/or chemical insults could
potentially affect the analytical process, then the process should be evaluated using known samples to
determine the effects of such factors.” (SWGDAM, July 2003)

Lack of amplification of some loci
As with any multi-locus system, the possibility exists that not every locus amplifies. This possibility is

most often observed when the DNA sample contains PCR inhibitors or when the DNA sample has been
severely degraded. Valuable information can be obtained from partial profiles.
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Degraded DNA
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As the average size of degraded DNA approaches the size of the target sequence, the amount of PCR
product generated is reduced. This is due to the reduced number of intact templates in the size range
necessary for amplification.

Degraded DNA was prepared to examine the potential for preferential amplification of loci. High
molecular weight Raji DNA was sonicated and incubated with increasing doses of DNase | (0-6 Units)
for 20 minutes (Bender et al., 2004). The DNA was examined by capillary electrophoresis analysis to
determine the average size of the DNA fragments at each time point.

1 ng of degraded DNA was amplified using the MiniFiler™ kit and AmpFZSTR™ Identifiler™ PCR
Amplification Kit. 2 ng of degraded DNA was amplified using the AmpF{STR™ SGM Plus™ PCR
Amplification Kit. As the DNA became increasingly degraded, the larger size Identifiler™ kit and SGM
Plus™ kit loci became undetectable. However, amplification with the MiniFiler™ kit resulted in an
increased overall typing success rate.
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Figure 24 Amplification of Raji DNA samples untreated or sonicated for 5 minutes and incubated with
DNase I (Y-axis scale 0-1,000, 0-3,000, 0-4,000, or 0-8,000).

Y

The performance of the three kits was compared in a simulated model of DNA degradation (sonication
and DNase | treatments). Only those loci (>50 RFU) represented in the MiniFiler™ kit were measured

in the Identifiler™ and SGM Plus™ kits. A complete profile with Raji DNA yields 14 peaks using the
MiniFiler™ kit. See Table 9.
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Table 9 Comparison of MiniFiler™, Identifiler™, and SGM Plus™ kit performance in simulated DNA

degradation (n=3)

Number of alleles detected
DNase |
MiniFiler™ Kit Identifiler™ Kit SGM Plus™ kit
0 units 14/14,14/14,14/14 14/14,14/14,14/14 10/10, 10/10, 10/10
4 units 14/14,14/14,14/14 8/14, 3/14, 4/14 2/10, 4/10, 5/10
5 units 14/14,14/14,14/14 3/14, 4/14, 4/14 2/10, 2/10, 2/10
6 units 14/14,14/14,13/14 0/14, 0/14, 0/14 0/10, 1/10, 1/10

Effect of inhibitors—hematin

76

Heme compounds have been identified as PCR inhibitors in DNA samples extracted from bloodstains
(DeFranchis et al., 1988; Akane et al., 1994). It is believed that the inhibitor is co-extracted and co-
purified with the DNA and subsequently interferes with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the performance of the MiniFiler™ kit, DNA Control 007 (1 ng

input DNA for the MiniFiler™ kit and Identifiler™ kit and 2 ng for the SGM Plus™ kit) was amplified with
increasing concentrations of hematin. The concentrations of hematin used were 0 uM, 20 M, 40 pM,
60 uM, and 80 pM. No preferential amplification was observed in the presence of increasing amounts of
hematin (Figure 25).
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Figure 25 Amplification of DNA Control 007 in the presence of hematin analyzed on a 3130x/ Genetic
Analyzer (Y-axis scale 0-400, 0-3,000, 0-4,000, or 0-8,000 RFU).

MiniFiler™ Kit

The performance of the three kits was compared in a simulated model of hematin inhibition. Only those
loci (>50 RFU) represented in the MiniFiler™ kit were measured in the Identifiler™ and SGM Plus™ kits. A
complete profile with DNA Control 007 yields 17 peaks using the MiniFiler™ kit. See Table 10.
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Table 10 Comparison of MiniFiler™, Identifiler™, and SGM Plus™ kit performance in simulated
hematin inhibition (n=3)

Number of alleles detected
Hematin concentration
MiniFiler™ kit Identifiler™ kit SGM Plus™ kit
20 uM 1717, 17/17,17/17 1717, 17/17,17/17 14/14,14/14,14/14
40 uM 17/17,17/17,17/17 17/17,17/17, 9/17 14/14,14/14, 14/14
60 uM 17/17,17/17,17/17 2/17,2/17, 0/17 2/14,1/14, 2/14
80 uM 17/17,17/17,17/17 0/17,0/17, 0/17 0/14, 0/14, 0/14

Effect of inhibitors—humic acid

Traces of humic acid can inhibit the PCR amplification of DNA evidence collected from soil. In this
study, we tested increasing amounts of humic acid in the PCR amplification of 1 ng of DNA Control
007 with the Identifiler™ kit and the MiniFiler™ kit and 2 ng with the SGM Plus™ kit. As the concentration
of humic acid increased in the reaction, the larger Identifiler™ kit and SGM Plus™ kit loci failed to
amplify. However, the MiniFiler™ kit loci efficiently amplified the DNA at concentrations of humic acid
that inhibited the amplification of DNA with the Identifiler™ kit and SGM Plus™ kit (Figure 26). The
concentrations of humic acid tested were 0, 10, 30, and 50 ng/pL.
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Figure 26 Amplification of DNA Control 007 in the presence of humic acid analyzed on a 3130x/ Genetic

Analyzer (Y-axis scales 0-400, 0-2,400, 0-4,000, or 0-7,000)

The performance of the three kits was compared in a simulated model of humic acid inhibition. Only

those loci (>50 RFU) represented in the MiniFiler™ kit were measured in the Identifiler™ and SGM Plus™

kits. A complete profile with DNA Control 007 yields 17 peaks using the MiniFiler™ kit. See Table 11.
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Table 11 Comparison of MiniFiler™, Identifiler™, and SGM Plus™ kit performance in simulated humic

acid inhibition (n=5)

Humic acid Number of alleles detected
concentration MiniFiler™ kit Identifiler™ kit SGM Plus™ kit
10 ng/uL 17A17,1717, 1717, 1717, | 1717, 1717, 1717, 17/17, | 14/14, 14/14, 14/14,
1717 14/17 14/14, 14/14
30 ng/pL 17/17,17/17,1717,17/17, | 0/17, 0/17, 0/17, 0/17,0/17 | 0/14, 0/14, 0/14, 0/14,
1717 0/14
50 ng/uL 17/17,17/17,17/17,17/17, | 0/17, 0/17, 0/17, 0/17,0/17 | 0/14, 0/14, 0/14, 0/14,
14/17 0/14

Mixture studies

SWGDAM guideline 2.8

“The ability to obtain reliable results from mixed source samples should be determined.” (SWGDAM,

July 2003)

Mixture study overview

Evidence samples that contain body fluids and/or tissues originating from more than one individual are
an important category of forensic casework.

It is essential to ensure that the DNA typing system is able to detect DNA mixtures. Typically, mixed
samples can be distinguished from single-source samples by:

* The presence of more than two alleles at one or more loci

* The presence of a peak at a stutter position that is significantly greater in percentage than typically
observed in a single-source sample

¢ Significantly imbalanced alleles for a heterozygous genotype

The possibility of multiple contributors should be considered when interpreting the results. Perform
studies to determine a minimum peak height threshold to avoid typing when stochastic effects are likely
to interfere with accurate interpretation of mixtures.

The peak height ratio is defined as the height of the lower peak (in RFU) divided by the height of the
higher peak (in RFU), expressed as a percentage.

80
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If an unusually low peak height ratio is observed for one locus, and there are no other indications
that the sample is a mixture, re-amplify and reanalyze the sample to determine if the imbalance is
reproducible. Possible causes of imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

¢ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as efficiently as the other
allele

Mixture study observation

Mean, median, minimum, and maximum peak height ratios observed for alleles in the MiniFiler™ kit loci
in unmixed human population database samples are shown in Table 12.

Table 12 Peak height ratios for 0.5 ng input DNA

Locus Number of observations (n) Mean Median Minimum Maximum
CSF1PO 781 87.9 89.3 57.9 100.0
D2S1338 911 87.0 88.8 52.3 100.0
D7S820 820 88.1 89.7 58.4 100.0
D13S317 733 88.4 90.4 50.5 100.0
D16S539 804 87.5 89.1 46.1 100.0
D18S51 906 87.9 89.2 55.1 100.0
D21S11 856 88.2 90.0 471 100.0
FGA 904 88.0 89.4 53.9 100.0

Resolution of genotypes in mixed samples

A sample that contains DNA from two sources can comprise (at a single locus) any of the following
seven genotype combinations:

* Heterozygote + heterozygote, no overlapping alleles (four peaks)

* Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
* Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)

* Homozygote + homozygote, no overlapping alleles (two peaks)

* Homozygote + homozygote, overlapping allele (one peak)
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Specific genotype combinations and input DNA ratios of the samples contained in a mixture determine
whether or not it is possible to resolve the genotypes of the major and minor components at a single
locus.

The ability to obtain and compare quantitative values for the different allele peak heights on Applied
Biosystems™ instruments provides additional valuable data to aid in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the analyst in the context
of each particular case, including the information provided from known reference samples.

Limit of detection of the minor component

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 3:1, 7:1, 15:1, 1:0). The
total amount of genomic input DNA mixed at each ratio was 1 ng. The samples were amplified in a
GeneAmp™ PCR System 9700, then electrophoresed and detected using a 3130x/ Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 27, where samples A and B were

mixed according to the ratios indicated. The minor component allele calls at non-overlapping loci

are highlighted. Detection of full profiles for the minor contributor was possible at ratios of 3:1
(0.750:0.250 ng) and 7:1 (0.875:0.125 ng). Generally, 15:1 ratios resulted in partial profiles for the minor
component. The profiles of these samples are described in Table 13.

The MiniFiler™ kit has been optimized to reliably amplify and type ~0.50-0.75 ng of single source DNA.
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Figure 27 Amplification of DNA mixtures at various ratios. Panels show electropherograms for (top to bottom)
1:0 (major contributor only), 15:1 mixture, 7:1 mixture, 3:1 mixture, 1:1 mixture, and 0:1 (minor contributor only).

82

AmpFESTR™ MiniFiler™ PCR Amplification Kit User Guide



Chapter 5 Experiments and results ~ [§Fa%
Population data

Table 13 Genotypes of mixed DNA samples

Locus Sample A genotype Sample B genotype
D13S317 11 12,14
D7S820 7,12 8,9
Amelogenin X, Y X, Y
D251338 20, 23 20, 21
D21S11 28, 31 28, 30
D16S539 9,10 12,13
D18S51 12,15 17,19
CSF1PO 11,12 10
FGA 24, 26 21,22

Population data

SWGDAM guideline 2.7

“The distribution of genetic markers in populations should be determined in relevant population
groups.” (SWGDAM, July 2003)

Loci in the kit

The MiniFiler™ kit contains loci for which extensive population data are available. For additional
information on 8 loci shared between many of the AmpF£STR™ kits, see the population data
and additional studies section of the AmpF£STR™ Identifiler™ PCR Amplification Kit User Guide
(Pub. No. 4323291).

Population distribution

To interpret the significance of a match between genetically typed samples, you must know the
population distribution of alleles at each locus in question. If the genotype of the relevant evidence
sample is:

¢ Different from the genotype of the reference sample for a suspect, then the suspect is excluded as
the donor of the biological evidence that was tested. An exclusion is independent of the frequency
of the two genotypes in the population.

* The same as the genotype of the reference sample for a suspect, then the suspect is included as a
possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence sample is estimated by
the frequency of that genotype in the relevant populations.
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Analysis across Thermo Fisher Scientific databases

Analysis across four Thermo Fisher Scientific databases of 2,274 total chromosomes per locus revealed
the following number of different alleles: 10 CSF1PO alleles, 13 D2S1338 alleles, 9 D7S820 alleles,
8 D13S317 alleles, 8 D16S539 alleles, 20 D18S51 alleles, 26 D21S11 alleles, and 31 FGA alleles.

In addition to the alleles that were observed and recorded in the Thermo Fisher Scientific databases,
other alleles have been published or reported to us by other laboratories (see the STRBase at
www.cstl.nist.gov/div831/strbase).

Low-frequency alleles

Some alleles of the MiniFiler™ kit loci occur at a low frequency. For these alleles, a minimum frequency
(5 divided by 2n, where n equals the number of individuals in the database) was assigned for the
MiniFiler™ kit African-American, U.S. Caucasian, U.S. Hispanic, and Native American databases, as
suggested in the 1996 report of the Committee on DNA Forensic Science (National Research Council,
1996). These databases are summarized in the AmpF¢STR™ Identifiler™ PCR Amplification Kit User
Guide (Pub. No. 4323291). The minimum reportable genotype frequency at each locus is as follows:

* African-American database: 1.19 x 107
* U.S. Caucasian database: 1.19 x 10
e U.S. Hispanic database: 1.70 x 10~
* Native American database: 2.97 x 10~
[P? + p(1-p) B, where 8 = 0.01]
Therefore, the minimum combined multi-locus genotype frequency at 8 loci is as follows:
* African-American database: 4.02 x 10732
* U.S. Caucasian database: 4.02 x 10732
e U.S. Hispanic database: 6.98 x 1073
* Native American database: 6.05 x 1072°
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Concordance studies

Primer relocation in the MiniFiler™ kit could unintentionally lead to allele imbalance or allele dropouts
that are not found in the Identifiler™ PCR Amplification Kit. These may be caused by a SNP or a deletion
in the primer binding site. Experimental data was used to quantify allele calling differences between the
MiniFiler™ kit and the Identifiler™ kit.

We analyzed 1,064 samples from four different populations by comparing allele calls between the
Identifiler™ kit and MiniFiler™ kit. In the majority of samples analyzed, the results were found to be
concordant between the kits with some minor discordance, as shown in Table 14.

Table 14 Discordant genotypes between the MiniFiler™ and Identifiler™ kits across four different

populations
Locus African-American (n=347) Caucasian (n=353) Hispanic (n=207) | Asian (n=157)
D13s317[1 1.73% 0.57% 1.45% -
D7S820 0.29% — — -
CSF1PO — — 0.48% —
D16S539 1.73% - - 0.64%
D18S51 - — 0.48% -

' The variants leading to discordant genotypes in the D13S317 locus have been characterized previously (Drabek, 2004).

Mutation rate

Estimating germ-line mutations

Estimation of spontaneous or induced germ-line mutation at genetic loci can be achieved by comparing
the genotypes of offspring to those of their parents. From such comparisons the number of observed
mutations are counted directly.

Three CEPH family DNA sets were examined. 0.50 ng of DNA from each sample was amplified using
the MiniFiler™ kit and Identifiler™ kit, followed by analysis using a 3130x/ Genetic Analyzer. The families
examined included #1333 (9 offspring), #1340 (7 offspring), and #1345 (7 offspring), representing

23 meiotic divisions. The results showed concordance between MiniFiler™ kit and Identifiler™ kit
genotypes and confirmed that the loci are inherited according to Mendelian rules, as expected.

In previous studies, genotypes of ten STR loci that were amplified by the AmpF{STR™ SGM Plus™ PCR
Amplification Kit were determined for a total of 146 parent-offspring allelic transfers (meioses) at the
Forensic Science Service, Birmingham, England. One length-based STR mutation was observed at the
D18S11 locus; mutations were not detected at any of the other nine STR loci. The D18S11 mutation
was represented by an increase of one 4-bp repeat unit, allele 17 was inherited as allele 18 (single-step
mutation). The maternal/paternal source of this mutation could not be distinguished.
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Additional mutation studies

Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong, 1993; Hammond et
al., 1994; Brinkmann et al., 1995; Chakraborty et al., 1996; Chakraborty et al., 1997; Brinkmann et al.,
1998; Momhinweg et al., 1998; Szibor et al., 1998) of direct mutation rate counts produced:

* Larger sample sizes for some of the MiniFiler™ kit loci.

* Methods for modifications of these mutation rates (to infer mutation rates indirectly for those loci
where the rates are not large enough to be measured directly and/or to account for those events
undetectable as Mendelian errors).

Probability of identity

Probability of identity definition

The probability of identity (P)) value is the probability that two individuals selected at random will have
an identical genotype (Sensabaugh, 1982).

Probability of identity observation

The probability of identity (P)) values of the MiniFiler™ kit loci (individually and combined) are shown in
Table 15.

The P, values for the populations described in this section are approximately:
* African-American—1/1.53 x 1010
e U.S. Caucasian—1/1.22 x 1010
e U.S. Hispanic—1/9.57 x 10°
* Native American—1/4.82 x 10°

Table 15 Probability of identity (P)) values for the MiniFiler™ kit loci

Locus African-American U.S. Caucasian U.S. Hispanic Native American
CSF1PO 0.079 0.132 0.141 0.123
D251338 0.023 0.027 0.038 0.043
D7S820 0.085 0.063 0.083 0.081
D13S317 0.132 0.079 0.056 0.056
D16S539 0.077 0.097 0.090 0.082
D18S51 0.033 0.031 0.031 0.046
D21S11 0.037 0.044 0.047 0.074
FGA 0.034 0.035 0.032 0.031
Combined 6.52 x 101 8.21 x 10" 1.05 x 1010 2.08x 10710
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Probability of paternity exclusion

Probability of paternity exclusion definition

The probability of paternity exclusion (PE) value is the probability, averaged over all possible mother-
child pairs, that a random alleged father will be excluded from paternity after DNA typing using the STR
loci in the kit (Chakraborty, Stivers, and Zhong, 1996).

Probability of paternity exclusion observation
The PE values of the MiniFiler™ kit STR loci (individually and combined) are shown in Table 16.

Table 16 Probability of paternity exclusion values for the MiniFiler™ kit STR loci

Locus African-American U.S. Caucasian U.S. Hispanic Native American
CSF1PO 0.545 0.496 0.450 0.409
D251338 0.748 0.725 0.671 0.399
D7S820 0.591 0.582 0.574 0.492
D13S317 0.383 0.487 0.638 0.370
D16S539 0.649 0.566 0.567 0.428
D18S51 0.760 0.731 0.767 0.329
D21S11 0.737 0.708 0.586 0.399
FGA 0.760 0.766 0.739 0.309
Combined 0.99985 0.99976 0.99970 0.98188
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Overview

As part of a program to exercise greater control over raw materials used in the AmpF{STR™ PCR
Amplification Kits, manufacturing of the AmpliTag Gold™ enzyme and 10X PCR Buffer Il (Tris-KCI buffer)
components was transitioned from Roche Molecular Systems to Thermo Fisher Scientific.

Manufacturing of both components by Thermo Fisher Scientific is conducted according to the same
specifications previously used by Roche. The in-house components are established raw materials in our
other PCR amplification kits (for example, the NGM™, NGM SElect™ and Identifiler™ PLUS™ kits).
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Experiments

We performed studies to compare the performance of the MiniFiler™ kit that contains the in-house
components (updated kit) with the performance of the original kit, focusing on studies most relevant to
forensic DNA testing (see SWGDAM Guidelines effective January 1, 2011). Each laboratory using the kit
should assess their own requirements for evaluation of kits.

Our studies compared the performance of two Roche-manufactured enzyme and buffer lots (Control
mixes) with three new lots of buffer and two new lots of enzyme manufactured by Thermo Fisher
Scientific (Test mixes). Studies were performed using Test mixes containing both the enzyme and buffer
manufactured by Thermo Fisher Scientific.

Test' Control A mix Control B mix Test A mix Test B mix Test C mix
material
Buffer Control Buffer Control Buffer | Test Buffer Lot 1 | Test Buffer Lot 2 | Test Buffer Lot 3
Lot 1 Lot 2
Enzyme Control Enzyme | Control Enzyme | Test Enzyme Lot | Control Enzyme | Test Enzyme Lot
Lot 1 Lot 2 1 Lot 2 2

Each of the five mixes was used to perform reproducibility, sensitivity, degraded DNA, and inhibition
studies. All amplifications were performed using a GeneAmp™ PCR System 9700 with a silver block

or gold-plated silver block using the recommended amplification conditions and cycle number for the
MiniFiler™ kit. All data were run on a 3130x/ Genetic Analyzer with Data Collection Software v3.0 and
analyzed using GeneMapper™ ID-X Software. Subsequent data analysis was performed using Minitab™
Statistical Software. To minimize the effect of injection-to-injection variation on result interpretation,
peaks heights for all studies were normalized using an in-house, multicolor reference standard.

Reproducibility study

For the reproducibility study, 12 replicates of DNA Control 007 at 0.5 ng input and 3 negative control
replicates were amplified. The results were evaluated for intracolor balance, stutter percentage, and the

presence, signal intensity, and location of artifacts.
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Reproducibility study

Intracolor balance

No significant difference (<10% increase or decrease) in the level of intracolor balance was observed
between the Test and Control mixes with the exception of Control B Mix, which showed slightly
increased levels of intracolor balance for the FAM™ dye (blue) but decreased intracolor balance results
for the PET™ dye (red) (Figure 28). The levels of intracolor balance obtained for all Test and Control
mixes fall within the expected range of performance for the MiniFiler™ kit.
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Figure 28 Reproducibility study: intracolor balance
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Stutter percentages

Stutter percentage results for each marker were comparable across all Test and Control mixes. See

Figure 29.
114 Amp Con
—&— Control &
o 104 —B— Control B
g Tast &
t —h - TastE
g 9 TestC
L]
S
g 5.
S
a
=
3 74
-
1]
I
e °7
]
$ sl
4 4
e
T

Dye Color and Locus

Figure 29 Reproducibility study: mean stutter percentage
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Artifacts

Known artifacts observed showed the same morphology, signal intensity, and location in all Test and
Control mixes and did not exceed 50 RFU. No new artifacts were observed in the Test mixes.

No artifacts were observed in the Test and Control mixes for the 6-FAM™ dye (blue), NED™ dye (yellow),
and PET™ (red) dye. A very low-level artifact was visible in the VIC™ dye (green) at ~115 bp for all Test
and Control mixes but did not exceed 50 RFU. See Figure 30.

VIC® dye labeled artifacts at ~115 bp
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Test B

Test C

a2 s

Figure 30 Reproducibility study: known artifacts VIC™ dye (Y-axis scale 0-50 RFU)

Sensitivity study

For the sensitivity study, dilution series of 3 genomic DNA samples were amplified: 0.75 ng

(3 replicates), 0.5 ng, 0.25 ng, and 0.125 ng (4 replicates each). The results were evaluated for mean
referenced peak height, degree of linearity between input DNA concentration and peak height, level of
allelic dropout at 125 pg, and genotype concordance.
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Sensitivity study

Mean referenced peak height

!!l \'

WAS

Overall mean referenced peak height observations were consistent between all Test and Control mixes,
demonstrating equivalent performance. See Figure 31 and Figure 32.
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Figure 31 Sensitivity study: mean referenced peak heights for 3 genomic DNA samples
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Sensitivity study
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Figure 32 Sensitivity study: representative electropherograms for Sample 2 amplified using 250 pg input DNA
(Y-axis scale 0-500 RFU)
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DNA concentration and peak height

Sensitivity study

|

~ |

The calculated slope and R? values for each of the plotted curves are equivalent, showing comparable
relationships between peak height and DNA input amount for the Test and Control mixes. See

Figure 33.
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Figure 33 Sensitivity study: linear regression plot of combined mean referenced peak height for
3 genomic DNA samples

Allelic dropout

Allelic dropout was observed only at 125 pg input DNA concentration. Levels of allelic dropout at
125 pg were comparable across all Test and Control mixes and are compared in Table 17. Examples of
allelic dropout are shown in Figure 34 and Figure 35.

Table 17 Sensitivity study: summary of allelic dropout observed at 125 pg input DNA concentration

. Number of alleles Number of alleles Percent of alleles
Reagent mix | Number of samples
expected dropped dropped

Test A 3 51 2 4%
Test B 4 68 4 6%
Test C 4 68 2 3%
Control A 4 68 2 3%
Control B 4 68 4 6%
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Sensitivity study
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Figure 34 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Control B mix. Two alleles are
below the analysis threshold of 50 RFU: at the D18S51 locus in the NED™ dye (yellow); at the FGA locus in the
PET™ dye (red) (Y-axis scale 0-400 RFU)
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Sensitivity study
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Figure 35 Sensitivity study: electropherogram of 125 pg Sample 3 amplified with Test B mix. One allele
at the D7S820 locus in the FAM™ dye (blue) is below the analysis threshold of 50 RFU (Y-axis scale

0-300 RFU)

Genotype concordance

Genotypes for Test and Control mixes were 100% concordant. See Table 18.

Table 18 Sensitivity study: genotype concordance

DNA input amount Reagent mix Genotype concordance

125 pg Test A 100%
Test B 100%

Test C 100%

Control A 100%

Control B 100%

250 pg Test A 100%
Test B 100%

Test C 100%

Control A 100%
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Chapter 6 Performance validation after buffer and enzyme replacement
Degraded DNA study

Table 18 Sensitivity study: genotype concordance (continued)

DNA input amount Reagent mix Genotype concordance

250 pg Control B 100%
500 pg Test A 100%
Test B 100%

Test C 100%

Control A 100%

Control B 100%

750 pg Test A 100%
Test B 100%

Test C 100%

Control A 100%

Control B 100%

To reflect the specific design of the MiniFiler™ kit for degraded samples, 5 replicates of 0.5 ng degraded
DNA Control 007 and 5 replicates of 0.5 ng pristine DNA Control 007 were amplified. Results were
evaluated for intracolor balance, mean referenced peak height, and levels of allelic dropout (degraded
DNA replicates only).

Degraded DNA was prepared by first sonicating the DNA then treating with 1 U DNAse | enzyme for
increasing time increments to simulate increasing levels of degradation. A final input DNA concentration

of 500 pg was used for all amplifications.
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Degraded DNA study

Intracolor balance

No significant difference (<10% increase or decrease) in the level of intracolor balance was observed
between the Test and Control mixes on degraded or pristine DNA, with the exception of Test A Mix.
Test A Mix showed higher levels of intracolor balance for the NED™ (yellow) dye in degraded samples.
The levels of intracolor balance obtained for all Test and Control mixes fall within the expected range of
performance for the MiniFiler™ kit.
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Figure 36 Degraded DNA study: intracolor balance 0.5 ng input DNA amount
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Degraded DNA study

Mean referenced peak height

Overall mean referenced peak height observations were consistent between all Test and Control mixes
with the exception of Test C Mix on pristine DNA. Test C Mix showed slightly higher referenced peak
heights overall. The mean referenced peak height results for all Test and Control mixes fall within the
expected range of performance for the MiniFiler™ kit.
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Figure 37 Degraded DNA study: intracolor balance 0.5 ng input DNA amount
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Allelic dropout

Chapter 6 Performance validation after buffer and enzyme replacement

(]
Degraded DNA study

Simulated degraded samples showed an overall drop in peak height compared to pristine DNA
samples. Peak height of the higher molecular weight loci showed a greater drop in peak height
compared to lower molecular weight loci, in some cases leading to allelic dropout. This is representative
of the typical pattern observed in partially degraded samples. Profile morphology and levels of allelic
dropout were comparable across all Test and Control mixes demonstrating equivalent performance.

Table 19 Degraded DNA study: summary of allelic dropout observed at 125 pg input DNA

concentration

. Number of alleles Number of alleles Percent of alleles
Reagent mix | Number of samples
expected dropped dropped
Control A 5 85 3 4%
Control B 5 85 9 11%
Test A 5 85 12 14%
Test B 5 85 5 6%
Test C 5 85 13 15%
Control A
3 l A l LA 1 - 1 ‘ ‘1‘ A A A A -
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[ Mark Szmple Fee Dakion
TestA
,.A—hLL_.L_LL_l 1 i hl A d A -
] Mk Senple Fur Daktion
Test B
‘ ‘ A A e l 1 1 m a A A A
[ Mark Szmple Fee Dakion
1 Test C
A A l Y L i h‘ A A - A

Figure 38 Degraded DNA study: representative electropherograms from 500 pg input DNA amplifications of
simulated degraded DNA samples (Y-axis scale 0-1,000 RFU)
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Figure 39 Degraded DNA study: representative electropherograms from 500 pg input DNA amplifications of
pristine DNA samples for comparison to simulated degraded samples (Y-axis scale 0-5,000 RFU)

Inhibition study

An inhibition series of 0.5 ng DNA Control 007 (consisting of uninhibited control, humic acid at a

final concentration of 50 ng/uL, and hematin at a final concentration of 45 uM in replicates of 5) was
amplified using each Test and Control mix. The amount of each inhibitor tested was titrated to cause
an ~50% reduction in overall peak height of the samples. Results were evaluated for mean referenced
peak height, minimum referenced peak height, intracolor balance, and levels of allelic dropout.

Mean peak height, minimum mean peak height, and intracolor balance

No significant difference in mean peak height or mean minimum peak height was observed for any Test
or Control mixes tested on DNA Control 007 inhibited with hematin or humic acid. A significant increase
in intracolor balance was observed only for Control A mix on DNA Control 007 inhibited with hematin
(Figure 40, Figure 41, and Figure 42).

More variation was seen in mean peak height, mean minimum peak height, and intracolor balance on
uninhibited DNA. This is not unexpected because the MiniFiler™ kit was designed and developed for
use on inhibited or degraded samples and is optimized for performance on such sample types. All
results obtained for all Test and Control mixes fall within the expected range of performance for the
MiniFiler™ kit.
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Figure 41 Inhibition study: minimum referenced peak height
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Inhibition study
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Figure 42 Inhibition study: intracolor balance

Representative electropherograms from the inhibition study are shown in Figure 43, Figure 44, and
Figure 45.
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Inhibition study
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Figure 43 Inhibition study: representative electropherograms using uninhibited DNA Control 007 (Y-axis scale

0-3,000 RFU)
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Inhibition study
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Figure 44 Inhibition study: representative electropherograms using DNA Control 007 inhibited with 45 yM of
hematin (Y-axis scale 0-3,000 RFU)
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Figure 45 Inhibition study: representative electropherograms using DNA Control 007 inhibited with 50 ng/pL of
humic acid (Y-axis scale 0-3,000 RFU)

Allelic dropout

No allelic dropout events were seen for any Test or Control mixes tested on uninhibited DNA Control
007 and DNA Control 007 inhibited with hematin or humic acid.

Conclusions

Laboratories can expect to obtain equivalent quality profiles across a wide range of forensic samples
when using the MiniFiler™ kit that contains the AmpliTag Gold™ enzyme and 10X PCR Buffer II
manufactured by Thermo Fisher Scientific as compared to the original MiniFiler™ kit that contains the
AmpliTag Gold™ enzyme and 10X PCR Buffer Il manufactured by Roche Molecular Systems.
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from DNA Control
007 and the test samples at all loci

The incorrect volume of master
mix or primer set was used.

Use the correct volume of master mix
or primer set.

The DNA polymerase was not
activated.

Repeat the amplification with an initial
hold for 11 minutes at 95°C.

The master mix was not
vortexed thoroughly before
aliquoting.

Vortex the master mix thoroughly.

The primer set was exposed to
too much light.

Replace the primer set and store it
protected from light.

The thermal cycler
malfunctioned.

See the thermal cycler user guide and
check the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use the correct thermal cycler
conditions.

Insufficient PCR product was
electrokinetically injected.

Use the correct settings for the
capillary electrophoresis instrument.

Degraded formamide was used.

Ensure that the formamide is correctly
stored. Do not thaw and refreeze the
formamide multiple times. Try using
Hi-Di™ Formamide.

Positive signal from DNA Control 007
but partial or no signal from the test
samples

The quantity of test DNA sample
is below the assay sensitivity.

Quantify DNA and (when possible)
add 0.5-0.75 ng of DNA.

The test sample contains a high
concentration of PCR inhibitor
(for example, heme compounds,
certain dyes).

Quantify the DNA, then use the
minimum required volume of test
sample DNA.

Wash the sample in a Centricon™-100
centrifugal filter unit.

The test sample DNA is severely
degraded.

Use the Quantifiler™ HP DNA
Quantification Kit or the Quantifiler™
Trio DNA Quantification Kit to
evaluate sample quality during

the quantification step. If DNA

is degraded, re-amplify with an
increased amount of DNA.

The test sample was diluted in
the wrong buffer (for example, a
TE buffer with an incorrect EDTA
concentration).

Redilute DNA using low-TE buffer
(with 0.1 mM EDTA).
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Appendix A Troubleshooting
Conclusions

Observation

Possible cause

Recommended action

More than two alleles present at a
locus

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid
introducing foreign DNA during
laboratory handling.

Too much DNA was present in
the reaction.

Use the recommended amount of
template DNA: 0.5-0.75 ng.

The test sample contained
mixed DNA.

See “Extra peaks: Stutter” on
page 61.

Stutter product (1 repeat unit
position) was amplified.

See “Extra peaks: Stutter” on
page 61.

Incomplete 3’ A base addition
(n-1 bp position) occurred.

In the PCR, include the final extension
step: 45 minutes 60°C. See “Extra
peaks: Addition of 3' A nucleotide” on
page 67.

The signal exceeds the dynamic
range of the instrument and is
causing "off-scale" data.

Ensure that the cycle number is
optimized. Use fewer PCR cycles or
interpret the off-scale data according
to your laboratory procedure.

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set G5 modules
are installed and used for analysis.

Some, but not all, loci are visible on

test sample electropherograms

The test sample DNA is severely
degraded.

Use the Quantifiler™ HP DNA
Quantification Kit or the Quantifiler™
Trio DNA Quantification Kit to
evaluate sample quality during

the quantification step. If DNA

is degraded, re-amplify with an
increased amount of DNA.

The test sample contains a high
concentration of PCR inhibitor
(for example, heme compounds,
certain dyes).

Quantify the DNA, then use the
minimum required volume of test
sample DNA.

Wash the sample in a Centricon™-100
centrifugal filter unit.
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3rd Order Least Squares sizing
method

When 10 USE . ..ot e e e e e e 110
About the Local Southern algorithm . ... .. e e 110
Comparing genotyping @CCUIACY . ..ot vvti ettt e e e e e e e et et e e et e 111

You can use the 3rd Order Least Squares sizing method as an alternative to the Local Southern method
when analyzing MiniFiler™ kit data.

When to use

We recommend using the 3rd Order Least Squares sizing method to size data obtained when analyzing
MiniFiler™ kit data using the GeneScan™ 500 LIZ™ Size Standard.

The Least Squares methods (both 2nd Order and 3rd Order) use regression analysis to build a best-fit
size-calling curve. This method is used to extrapolate sizes that extend beyond the physical range of
the size standard. Small (<75 bp) fragments generated by the MiniFiler™ kit can be sized using the
GeneScan™ 500 LIZ™ Size Standard.

About the Local Southern algorithm

110

For the highest level of accuracy, the Local Southern method requires two size-standard fragments
below the smallest unknown fragment and two size-standard fragments above the largest unknown
fragment. All AmpF£STR™ kits except the MiniFiler™ kit, have an allele size range between 100-360 bp.
Optimal genotyping accuracy of all kits other than the MiniFiler™ kit requires detection of all GeneScan™
500 LIZ™ Size Standard (or ROX™ dye) fragments between 75-450 bp (or 75-400 bp depending on the
kit).

In the MiniFiler™ kit, the amplicon sizes for the large AmpF{STR™ loci have been decreased to improve
genotyping performance with degraded and inhibited DNA samples. The allele range for the MiniFiler™
kit is 70-283 bp. To use the Local Southern algorithm, at least one peak <70 bp would have to be
detected.

Although the GeneScan™ 500 LIZ™ Size Standard does contain 50-bp and 35-bp size-standard peaks,
they are often difficult or impossible to detect. The fragments are obscured by the primer front
associated with the MiniFiler™ kit amplifications.

Because fragment sizes cannot be extrapolated when using the Local Southern algorithm, we
recommend the 3rd Order Least Squares algorithm as an alternative sizing method for the MiniFiler™ kit.
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Appendix B 3rd Order Least Squares sizing method
Comparing genotyping accuracy

For a full description of the Least Squares Method, see the GeneMapper™ ID-X Software v1.5 Reference
Guide (Pub. No. 100031707).

Comparing genotyping accuracy

We compared the Local Southern and 3rd Order Least Squares methods for genotyping accuracy,
using a dataset of 1,156 Identifiler™ kit amplifications. The amplified samples were from a single source,
electrophoresed on a 3100 or 3130x/ Genetic Analyzer, and sized with the GeneScan™ 500 LIZ™ Size
Standard. The samples were analyzed using both sizing methods and their allele calls were compared.
The size standard definitions for both methods include all the peaks from 75-450 bp, except for the
250-bp peak.

The genotyping results (n=36,000 alleles) for the two methods were compared for concordance. The
genotyping accuracy rates for the Local Southern and 3rd Order Least Squares algorithms were
equivalent. No alleles were labeled with an incorrect genotype and only a very small percentage (Local
Southern, 0.05%; 3rd Order Least Squares, 0.008%) of the alleles were designated as off-ladder when
they did not represent a true microvariant allele. All the discordant off-ladder allele calls were within
0.08 bp of the +0.5 bp offset for the bin sizing window.
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Materials required but not supplied

Sample preparation (PCR or CE) required materials ........... ... .. ... ... 112
Thermal cycler required materials . ... ... e 112
Capillary electrophoresis instrument required materials ......... ... .. ... ... ... . L. 113
Analysis software required materials . .. ... e 115
Miscellaneous required materials .. ......... .. i i e 115

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Sample preparation (PCR or CE) required materials

ltem Amount Cat. No.
Size standard (only one is required) GeneScan™ 500 LIZ™ Size 2 x 200 pL 4322682
Standard
IMPORTANT! Do not use GeneScan™ 350
ROX™ or GeneScan™ 500 ROX™ Size GeneScan™ 600 LIZ™ Size 2 x 200 pL 4408399
Standards with this kit. Standard v2.0
TE Buffer [low-TE buffer; 10 mM Tris-HCI (pH 8.0) and 0.1 mM EDTA] 100 mL 12090015

or see “(Optional)
Prepare low-TE buffer”

on page 19

Hi-Di™ Formamide 25 mL 4311320
Thermal cycler required materials

ProFlex™ PCR System

ltem Source

ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
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Appendix C Materials required but not supplied
Capillary electrophoresis instrument required materials

VeritiPro™ Thermal Cycler

Item Source

HID VeritiPro™ Thermal Cycler, 96-well A52127

Capillary electrophoresis instrument required materials

SeqStudio™ Flex Series Genetic Analyzer for Human ldentification

Iltem Source
SeqStudio™ 8 Flex Genetic Analyzer for Human Identification with SeqStudio™ Flex Series Instrument
Software v1.1.1 AS6532
SegStudio™ 24 Flex Genetic Analyzer for Human Identification with SeqStudio™ Flex Series Instrument
Software v1.1.1 A56534
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
Septa Cathode Buffer Container 3500/Flex Series 4410715
Capillary array 36-cm SeqStudio™ 8 Flex A49104
Capillary array 36-cm SeqStudio™ 24 Flex A49105
96-Well Standard Retainer & Base Set SeqStudio™ Flex Series A49316
8-Tube Standard Retainer & Base Set SeqStudio™ Flex Series A49296
8-Strip Septa 3500/Flex Series 4410701
Septa for 96-Well Plates, for 3500/SeqStudio™ Flex 4412614
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
POP-4™ (960) Performance Optimized Polymer 4393710
POP-4™ (384) Performance Optimized Polymer 4393715
Conditioning Reagent Kit 3500/Flex Series 4393718
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Appendix C Materials required but not supplied
Capillary electrophoresis instrument required materials

SeqStudio™ Genetic Analyzer for HID

Iltem Source
SeqStudio™ Genetic Analyzer for HID with SeqStudio™ Data Collection A4G227
Software v1.2.1, v1.2.4, or v1.2.5
(Optional) SAE Administrator Console v2.0 or v2.1 A46170 or A53717
(Optional) SeqStudio™ Plate Manager v1.2 or v1.3 Available on apps.thermofisher.com or

for download at thermofisher.com

SeqgStudio™ Genetic Analyzer Cartridge v2 A41331
SeqStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for Cathode Buffer Container) A35640
SeqStudio™ Integrated Capillary Protector A31923
Septa for SeqStudio™ Genetic Analyzer, 96 well A35641
Septa for SeqStudio™ Genetic Analyzer, 8 strip A35643
DS-33 Matrix Standard Kit (Dye Set G5) 4345833

3500 Series Genetic Analyzer for Human Identification

Item Source
3500 Genetic Analyzer for Human Identification with 3500 Series Data Collection Software 4 4406017
3500xL Genetic Analyzer for Human Identification with 3500 Series Data Collection Software 4 4406016
(Software upgrade package) 3500 Series HID Data Collection Software v4.0.1 A46085
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
Septa Cathode Buffer Container 3500/Flex Series 4410715
3500 Genetic Analyzer 8-Capillary Array, 36 cm 4404683
3500xL Genetic Analyzer 24-Capillary Array, 36 cm 4404687
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 96 well 4410228
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 8 tube 4410231
8-Strip Septa 3500/Flex Series 4410701
Septa for 96-Well Plates, for 3500/SeqStudio™ Flex 4412614
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
POP-4™ (960) Performance Optimized Polymer 4393710
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Appendix C Materials required but not supplied
Analysis software required materials

(continued)

Item Source
POP-4™ (384) Performance Optimized Polymer 4393715
Conditioning Reagent Kit 3500/Flex Series 4393718

Analysis software required materials

GeneMapper™ ID-X Software

Item Source
GeneMapper™ ID-X Software v1.7.2 patchl'] Thermo Fisher Scientificl?!
GeneMapper™ ID-X Software v1.7 Full Installation A71700
GeneMapper™ ID-X Software v1.7 Client Installation A71701
GeneMapper™ ID-X Software v1.6 Full Installation A39975
GeneMapper™ ID-X Software v1.6 Client Installation A39976
GeneMapper™ ID-X Software v1.5 Full Installation A27884
GeneMapper™ ID-X Software v1.5 Client Installation A27886

' The patch addresses known issues and provides new user functionality since the v1.7 release.
Pl Available for free download at www.thermofisher.com/GMIDXsoftware.

Note: For a list of GeneMapper™ ID-X Software versions that are compatible with your kit and capillary
electrophoresis instrument, see “Instruments and software compatibility” on page 15.

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Tube Strip, 0.2 mL 4316567
MicroAmp™ Optical 8-Cap Strips 4323032
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Appendix C Materials required but not supplied
Miscellaneous required materials

(continued)
ltem Source
MicroAmp™ 96-Well Tray/Retainer Set
403081
(Adapter for 8-Tube Strip)
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
MicroAmp™ Optical 96-Well Reaction Plate with Barcode 4326659
Laboratory supplies
Iltem Source
Various procedures
Aerosol resistant pipette tips mMLS!
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
(Optional) Handheld Barcode Scanner 4488442

' Major laboratory supplier

116

AmpFESTR™ MiniFiler™ PCR Amplification Kit User Guide



https://www.thermofisher.com/order/catalog/product/403081
https://www.thermofisher.com/order/catalog/product/N8010531
https://www.thermofisher.com/order/catalog/product/4306311
https://www.thermofisher.com/order/catalog/product/4311971
https://www.thermofisher.com/order/catalog/product/N8010560
https://www.thermofisher.com/order/catalog/product/4326659
https://www.thermofisher.com/order/catalog/product/4488442

PCR work areas

Work area setup and lab design . . ... oo e 117
PCR setup work areamaterials .. ...... ... i e 117
Amplified DNA WOrK area . ... ... e e e e e e 118

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility Planning, Design,
Construction, and Moving", National Institute of Justice, 1998

* Parentage DNA testing, see the "Guidance for Standards for Parentage Relationship Testing
Laboratories", American Association of Blood Banks, 7th edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute quantities of DNA,
necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi,
1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at all times and
change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling
sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all precautions and care
necessary for using PCR technology.

PCR setup work area materials

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube (for master mix
preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettes
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Appendix D PCR work areas
Amplified DNA work area

* Tube decapper that can be autoclaved
* \ortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

Use only the validated thermal cyclers listed in “Instruments and software compatibility” on page 15.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix E Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Appendix E Safety
Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
cdc.gov/labs/bmbl

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Table 20 STR and quantification kits

Document title Pub. No.
STR kits
AmpF¢STR™ MiniFiler™ PCR Amplification Kit User Guide MAN0029851
AmpF¢STR™ Identifiler™ PCR Amplification Kit User Guide 4323291

Technical Note: Handling STR Kits and Ladder Decontamination

Go to thermofisher.com, then search for the
technical note by title, or contact your local
Human Identification representative.

Quantification kits

Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User
Guide

4485354

Table 21 Thermal cyclers

Validation

Document title Pub. No.
ProFlex™ PCR System
ProFlex™ PCR System User Guide MANOO007697
ProFlex™ PCR System Kit Validation User Bulletin 100031595
VeritiPro™ Thermal Cycler
VeritiPro™ Thermal Cycler User Guide MANO0019157
HID VeritiPro™ Thermal Cycler, 96-well, User Bulletin— Applied Biosystems™ PCR Amplification Kit MANO0025561

' Archived document. To access, go to https://assets.thermofisher.com/TFS-Assets/LSG/manuals/

100031595_ProFlexKit_Validation_UB.pdf
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Appendix F Documentation and support

Related documentation
Table 22 Capillary electrophoresis instruments
Document title Pub. No.
SegStudio™ Flex Series Genetic Analyzer for Human Identification
SeqStudio™ Flex Series Genetic Analyzer with Instrument Software v1.1.1 User Guide 100104689
SeqStudio™ Flex Series Genetic Analyzer for HID Validation User Bulletin MANO0028463
SeqStudio™ Flex Series Instrument Software v1.1.1 User Bulletin MANO0029757
SegStudio™ Genetic Analyzer for HID
SeqStudio™ Genetic Analyzer Instrument and Software User Guide (v1.2 and later) MANO0018646
SeqStudio™ Genetic Analyzer for HID User Bulletin—New Software Features and MAN1001221
Verification/Validation Studies (v1.2 and later)
3500 Series Genetic Analyzer for Human Identification
3500 Series Data Collection Software 4 User Bulletin: New Features and Developmental Validation 100075298
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v3.3 User Guide 100079380

Table 23 Analysis software

Document title Pub. No.
GeneMapper™ ID-X Software all versions
GeneMapper™ ID-X Software Bin Overlap User Bulletin 100029546

Technical Note: Customizing GeneMapper™ ID-X Software Panel and Bin Sets to Include
or Exclude Internal Quality Control Markers in the Quality Value System (v1.5.2 and later)

Technical Note: Compendium of GeneMapper™ ID-X Software version changes from
version 1.0.1 through version 1.7.2

Thermo Fisher Scientificlll

GeneMapper™ ID-X Software v1.7

GeneMapper™ ID-X Software v1.7 Administration Guide MANO0029245
GeneMapper™ ID-X Software v1.7 Installation Guide MAN0029246
GeneMapper™ ID-X Software v1.7 New Features and Software Verification and MANO0029209
Validation User Bulletin

GeneMapper™ ID-X Software v1.6

GeneMapper™ ID-X Software v1.6 New Features and Software Verification User Bulletin 100073905
GeneMapper™ ID-X Software v1.5

GeneMapper™ ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
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Appendix F Documentation and support
Customer and technical support

Table 23 Analysis software (continued)

Document title Pub. No.
GeneMapper™ ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper™ ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper™ ID-X Software v1.5 Installation Guide 100031706
GeneMapper™ ID-X Software v1.5 Administrator Guide 100031703
GeneMapper™ ID-X Software v1.5 Reference Guide 100031707

M Go to thermofisher.com, then search for the technical note by title, or contact your local Human Identification representative.

Customer and technical support

For support, use one of the contact methods listed below, depending on your location.

Location Contact method

In North America Send an email to:

HIDTechSupport@thermofisher.com

Call 888-821-4443; select option 2, say "Application Support", then say "HID" or
"Human Identification".

Outside North America | Contact your local support office.

For the latest services and support information for all locations, go to thermofisher.com/support to
obtain the following information.

* Worldwide contact telephone numbers

* Product support

* Order and web support

e Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis, are available by
contacting Customer Support.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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